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MCS-51 s2¥52E [ Intel A F) 20— RF PSR . X—RF B PVEEE T2, 18031,
8051. 8751, 8032. 8052. 8752 &%, Hrf 8051 st HM I~ N, 1Z ARV At 5 - HLAS A2 LL 8051 4y
F O LB R LR IET, B A 8051 MIFEALE AR HERE, FrLA AT BT H 8051 SKRFKIF MCS-51 741

AL
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o 32 AR AN F-HE ) 1/O £

o 4KB FE/TAEAk S (ROMD, AMEHY 78 4 64KB;
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o 2416 P AT RS
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o XU AT H;
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LU HTFEE SIWRETER

1.1.1 FRA4ESS (CPU)

TRAE S (CPUD S 3N F R DL AZ O B, 2 8 A7 udls i FE R AL PGS, REAL T 8 A — HEwIHodhs sl AXHY
CPU TSt F45 A LA R GE N AT, 58 pda SN sl A\t DD REAE A1, 2 o LR R Lo B8 A
HaHgs ey CENERIIE) ML A fEardl 3 M4l

1. BHAE (ALU)

ISR ThRE AT HARS HAERIZ o n] DU 770 (4 40 B T S i d A T3 1 BERESS 5E N
Wos T, BREEDUNGEE, WATLASERCN 1. 8 1. BCD fig-HEHliHes, HESEARIZEM S, 5. Sl
KA TR GRS,

8051 IEH B IR — MR AL EE A, HIORACERA 8 4F, CABHAREN: C h Bnds, nTHATENL. AT,
B 25T 1R T 0 86R8. 25 T 1 688 Bl 0 UG ARGy 5 HoAth i 3Bk (A7 2 ) EA T i A% 3%
ST HRAE, WREAEEA AR A S o T S EE AL 2 AT B S . R

2. PEHgE

(1) W efg

8051 F AT At S [A) K 28 BT A B 1 9% 9% HEL 3% » XTALA FI XTAL2 43 1) A 415 % HaL % 160 B N\ i A 4 3
I my DA ph A7 AN 77 0 A2 e R DT 2k F B ) 12 s ./ XTALL T XTAL2 5| FAME
SENTCHE, PR W gt = A B AR o R ISP IC A R A O S AR L S A B RO PR [T o R
BRAE 1.2M~12MHz JEFH N, HAAE S~30pF Ji 8 Py, (HL 2 K/ ] i AT R A 4 ]

AN T S BR D, IR, TR XTALL #2h, XTAL2 #4MT & aslinr, Wl 1.3 fia. )
AN G5 5 IO R SR, R ORUE K . — R RS T 12MHz B 5355 .

C2
18 l XTAL2 SN 1SS ——] XTAL2
S
C1 T
& + | XTALI XTALI
GND GND
1.2 P37 AR b el i 1.3 ARy AR b el i

I P g, B R L TR R R A ORR, Ja SR R, (BRI AR DA R, XA S
TR Kk, ARG AFE AR BT E R SR A .

(2) Y3z AL Wb . LS A A R4 3

AR TR A I — R BB S AR R AT AR G S R IO SR T LI . 8051 1)
TN FPAES 11 FrpAvdl, X HLe A GILEEA 7 J 300

o R IS N B HUBS IR B 5 A PR UK R, S I P o i /N PRI ) B4R

o N PRI IRGIRAE 5 22 0 UG T UK I Bl K - R R 3T

o Hlats YIS 58 B DA AT PTG A 18] — LR A5 6 AN BRI, thaltds T 12 MR A 30
o AR FIESR CPU BT — 4482 F e ZAIN 8], 2 I P A (R KI () BA .  T-20 AL AT AN FIR 2
I RIS ], DRLSEAN TR 2 Bt & BB L F Bt AT ), — AN IR % 5 1~4 DL A 30
Pz AL bR L AL A IR S R sl 1.4 .
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2
s {171
! P EH
e FE 0
B 1.4 8051 B4 HLEFhE M Z B IR

5 MCS-51 P HLAME R A 12MHz i, R F AL 4 A0 AR N -
=% A I=1/121s=0.0833 s ;
B & 3=1/61s=0.167ps;
BLAS F IH=1ps;
§4 JE=1~4ps.

3. THERHSRA

L AP BRI S 4T B AT AL . A7 R E BRI R TR S PAT G PR ESEE, AT —6&
THEPLE) CPU ANn] sk (4l . 8051 ML M A fe a2l RO/ P18 (PCOL RN (ACC).
WHFAAE (B, BFIRET (PSW). Hidkdi nat (SP) AW fEr (DPTR) 45, I [ 4l % X 24 25 47
AT

(D) Ehn#s (ACO)

SIS 2 B E W RE R D e 75 A, A — > b 8 ALRF A, Ko B ME E R 2 R R B B2 2s,
IR Z AR ER AW — N RS A By o NS ik e, BRI RIS IR A W18 5 45 AR e R n#s
ACC 5 A. B Fifrdst. F82 R Al ACC AN B as Bd fF . Bilan “3+5” DEREP W T Fis:

MOV A,#03H ;A<3
ADD A,#05H ;A< A+O5H

84 “MOV  A#O3H” 4EIN% 3 Fidcik®l 2ngs A, N4 “ADD  A#0SH” AT MAES, Kk, f&
4 “ADD  AH#OSH” PATHT RN A o ing 3, 7EHATIEAR R F, Bk 8.
(2) WH A (B)
B A7 dn AL TPRIETR A i I 27 A48 . RIZFR PN RAE S I e A Fl B, HE R AFHHE B (5 8
PV A (I 8 1) Fifrdete BRiEFRA T, BEBREIE A, BEWA B, ML T A, REAFT B.
TEALAFR A, B AA74s nI/E ) RAM H R — A0 A o I T LASRed2aaz 55 0 461 o DA B -

MOV A,#03H ; A<3

MOV B,#05H ; B<5

MUL AB ; BA<A%B=5x3

AU 45 AL 15454, A TIHRIERTUES TR 2, TRVESRAPATHT B nas A FUEH 7574 B R miAeii 7
A TREL, TILIRAPATE, BN 8 A7 ABIAFIAE B, Ik 8 7 ABIFINAE A .

(3) RS T (PSW)
PP IRE TR 87748, WEH THEFIRSHELR, G AEREANE L 1.5 Fis:

PSW7 PSW6 PSWS5 PSw4 PSW3 PSW2 PSWI PSWO

CY AC FO RS1 RSO ov — P

B 1.5 FUPRETEMLmE X
Ho PSW1 K H, HASAL B0 F .
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o CY (Carry): Hfitrii. fEPATIHLCERFZHTG AW, W LA s B A B % . HoAAH
TEMEIE ST, 45 R nas A it A7 G, W CY=1, B0 CY=0; {EiEEHR, # A7 A4,
W CY=1, 50 CY=0; CPU {EHAT AL AR I 25 S M X AN bR &AL o AEA7 R AR BEAL A DA A S A7 220
ar, HHEZIVMEA Y T — b S PR 1) RN A
e AC (AuxiliaryCarry): FHBVEAIARRE . M3RHT DNy sy v m = 4= ik 4 A7%0 (BCD 5—47) [7
4 P RO B AE AT I, AC B RELE B A, A 2. AC ¥ H T BCD g4,
o FO (Flagzero): FH/'Ariifi. FO &M/ € LW — A REbRE, HRARAA L B B80S E . Zbr SRS
— W, A AR Fo,  DASHIRE T I .
e RSI. RSO (Registers Selection): Zif7asXIEPEIEHIAL. 8051 245 8 /N 8 AL TAEZ f74%, A altns
RO~R7. TAEZ A48 RO~RT H P RIATREF 1T, (HIAE RAM A1 S r 4 21 bk 2w DAAR 5 75 2
EE M. RS1 A1 RSO HL2&A TXA H ey P AT, APt 228 RST A RSO IR mT BT {5 1
YeE RO~R7 [ISEsa il . mT AR Aok B 53 22 DA 2 TAEZF 745X . RS1 FIl RSO 5 25 /785X [1)
PN R R WK 1-1 Pros.
e OV (Overflow): i thbra&. LA RIS SRR R A E T, S PAT SRS 2 i e 2 07 i
%, AR TAEIRIE SR . OV=1 T ndia B & FEH T H 24788 A PTReRon i 755451
2 (M) FITER (—128~+127) MPATINIELIRS ADD W, 1% 6 [MA4% 7 F LML 7 AN CY HEAT,
B 6 AN 7 LA 7 1) CY BEAZET, 6 AR OV EAL, IR,
TS HIRETR A M PAT S R i HAr . 375 T 2Ina A RZ 74 B PN RBUE T 255
i, Ov=1, &N OV=0, M 8 AL B N, i 8 fIBAE A We Bk, OV=0 kG HZ A HHL
PR TT, FNFN By A AR IRA, BRiLIRA s HArds: M ECh o 1, ov=1,
B OV=0,

e 30| i&@id RS1 %0 RSO 4% TARZ 75 4A
RS1. RSO RO~R7 BI4AS RO~R7 K32 ik
00 0 00H~07H
01 1 08H~O0FH
10 2 10H~17H
11 3 18H~1FH

o P (Parity): #Hilibri&. BG4 FIHHS il ok BT 80E “07, LA Bnds A HEh 1 A 30 A
o 5 1 AL ECh TS, P& “17, /P,

P bR AN AT AR AR A R R, AR AT AR AT AR AR IR 1R 7 e A e R A A )
ATAEME o fE R v AT AR PR B0 (1) A 8 A B 2 o WA B LR e SR AT A RS B K A, T P=0
i, MR (R B A U A AL E AL, A5 kG % .

(4) HirkFaEr (SP)

HERRFREE SP & —A 8 WA IR IR A A7 A%, AN R R HEAR T AE U RAM R E . RG S )G,
SP ¥l4ftk Ay 07TH, fFAFMEAR S bl 08H HocIFah. 83| 08H~ IFH Moo g T TAEA 74X 1~3,
PIREFF B R B S X, A3 SP A SCE  1FH 5 K IME, SP AIRILAME AN, HERR VR B ml vl LL
YR o HERGFRET IE T DA OAR, DRI HEARAE P36 RAM. A (407 B L R 3G o

(5) #HadREt (DPTR)

455t DPTR 2 — 16 MR Ae 5 A7, Hemfy 75 48 H DPH 7R, A7 17 % 745 H DPL
For, BETLUME R — 16 (L7547 4% DPTR SKRACHEE, tn] LUE /NS 8 47 %7 /7 #% DPH Al DPL kit
FI, DPTR FHIRAEIN 16 frkbdik, 4% 64KB AMEBAEfE 2e S0k, AT A ) dik 2 A7 28 1) .

(6) ity (PC)

R s (PC) HERAFBRKG EHAT IR A Mk, 3% 16 £, WX 64KB [IFEFP A7 fifi s B3 -0k 3K
TERBLEAMT R P A ds v 104 2 1), PC AR 8 728 PO i 4 th, /1 8 {728 P2 i 4
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112 fF#as4m

MCS-51 ¥ 5 HLIIA7 i A gl 7 2R 5 TAE A7 3% VO i IVBIAF 2 48— g bk it 7 2, R A7-6k AN 5
(i S e TARMOL I, &4 B T RENEGIE S, YRGBT FEPAFE 8 H A7t
& (ROM), HlaAfrfds MBENLA7 s (RAMD.

FE P AL At o8 FH R AT TBORE P AN R R B R 55, 0 W T R P 28V i (R LR o 5l A7 i 2 o 5 kA7
JRFE P2 AT T 7 B OMAR . B, OINYE R BN S Ok (R BRI e S AR B
by SIS R e 5

ML EE 7R A, MCS-51 47 4 Mt dsthbl 23], WP Eas AN A gs . I PR A7 g
AR AN AT RS, LA ZigE i 1.6 PR

P93 RAM

FFFFH FFH FFFFH
SFR
S ROM 80H
1000H RAM
’—‘—\ 30H LXK S RAM
OFFFH S ET—
AR
A ROM 4hi ROM 03 41
0000H 00H 0000H

K 1.6 8051 frfitasdlZigi

1. FBIFHeS

TR A7 2 P RATTORE 7 RO SRS . FRIP A7 it DARE o] 30ds PO 1R AREr, 8T 16 bl Sgk, ]
TR AR AR 64KB, FA L NS gdik.

75 8051/8751 Ji WA 4T 4KB [f] ROM/EPROM 217k 3 CNRFE P 474k 2% ), AKB I A7 LI T- 2 4164
X AN IN (R R L I R G B 88T, AN o INFE P A7 i, 45 WA, i nT 1k 8KB B 16KB
WAE R HLES - (D 89C52 48D, Rz, JSEAEY JRAINTIE A S, XA 0™ ik
L

IR RGEE D, B AP A A I, nTAMNT R g ds, BAAY B2 KW
SR HANKIE: —EREBREFAERN):; ZERT RO AERD, 64KB DA R 4KB B A FhH
REP R IR KA &

xF 8051/8751 T, AMBFRITFAEESEHbEZ % 1000H~FFFFH. WX B, #9% EA #AK S, ]
TR, RIE SR R O 5 N 5 ROM . 2% 18] 5833 I AN SR FE P A7-Ait 2 I, BEAT A 2.
RUFJGHBARE, B EA S iF, RIS T AT,

FERR T AT i P A SOy 2 () SR G AE A A b B DAV E R . e — 4R R .0 /2 0000H~0002H G, REEHR
fiJi, PC 24 0000H, 5L 0000H FFICHIAHATIRT, %P ICE RAPATIEF IR A IE, 18 H 7R X
FATCHAE IR — 4R HR A, T FH P R B il I 46 A7 TR

Ty —4URFR HL G S 0003H~002AH, 1X 40 /Moo syl 5 B, Mo k.

e 0003H~000AH: ZRrhlr 0 (1) rf itk X o

e 000BH~0012H: &I #5/iHEs 0 (1) Bribdik X

e 0013H~001AH: ZRrhWr 1 (1) rh btk X .

e 001BH~0022H: &I as/iH 5 1 1) Bribdikx .

e 0023H~002AH: H47HWriihkX

AIULRL BT 40 ANHRICE LTI FAEC R W AR BERR P I bk BT, T N S, de R 2R Y B B B &
H WX AT R . W BT DR, AR W RS FET HA 8 AN IG, 8 N FEARAEA
TR S AR 7 AR AE AN T REIN o T I D0 N AR T W R EE X AR — R TR R S, IRMAR A
i 245 () BC A A7 8P T IR 5 2 1R 203 () 5T o IXFErP TR Y J , CPU i BIIX 4B fia 2, % ) oAt by
ZAREEPAT IR S AR T
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1 WA FEF SINEFEL

2. BETFiERS

MCS-51 5 ML AR A7k ds O IR AEYEE L alaZ 48 Bl o A sk a],  — AN SR At s, Vil
NI EE AL MOV #5451 — AN NAMBEER Ak 45, U7 AN B A2 2% ) MOVX 454,

MCS-51 FRAVE P& E 7 PSR S A i, At R G I bk 2 (8], 43 s by i) HLAE A [R] 1
JUANX, Wil 1.6 Fizn. 8051 PIFBA 128 A~ 8 {7 H F Hidis A4k oo Al 128 ML A7 AE A% IR0, IR S8 T
Gi— k), L H AR HREH T dilde 2 2 . Prbl, H P sefi ) RAM 45 00H~7FH(0~127)
FICALE) 128 Sy bk A, wIAE IR S (A Bas L R 45 s SOH~FFH (128~255) HLIGAl K
[ 128 i ik 2% (B K RF R T BE A7 A7 2% (UK SFRY X BBV 1), TIANREFH TA7 U1 - bl

. on ' 8032/8052 % 4L ¥% SOH ~ FFH (128 ~255) %04l Mt 128 ¥ Hal = [F/EH RAM K,
=

by 2SN

Jr P RAM [ 128 #4715 (00H~7FH) & AT LAAr B TAEZF A7 A% X . AT Tk X F1—fF RAM X 3 Mk,
JLIhRe. FERSAR

o TAFZFAFAEX: 75 O0H~1FH 24T 4 4 TAEG 4745, 415 H 8 I~ RAM #7157, 1k RO~R7. fEkt
A%, CPU MR FHIL 1) — 2 TAE T A7, TAE R A7 a5 I e th R IR A7 (PSW) A (1 457 K Aff 22
o {7 THEX: A 20H~2FH 3t 16 AN, M 20H IS OS] 2FH BT 7 A 235 128 i,
FAAz HhE 00H~7FH 43 5 5 2 0 W o 3% AN DXk ER T 1T LAVE I —#E RAM BLGH AT B S Ak, ] LI
AN LA ATEAE, — AP IO B R A (R 5

o —f% RAM [X: Huhib>hy 30H~7FH, #t 80 AF1r, wEN—MHIEN RAM, WIHFHFE T A RS,

FEIR T BB 25 A7 A TP AT — 30 A2 T 1, XA AT e b AT A & S EUR I 1 45 - 8051
TR DI Re A AL R AT S MR AN SR 1-2 P, Jorfaly o7 S5 (PR IR D) BE 25 A7 AR A2 T LA SRR, JERT R
M “TArds a7 KEKIR, W ACC.0. B.7 %

MCS-51 HAY JE 64KB HM et 47 Gt S he g, 3300 R 22 W AR O 2 05, X6 B B A7 i 2% (1 U
i KA MOVX #8584, HM#E: 87750, ROv R1FI DPTR #B ] Al bk 25 4745 .

12 8051 H5 AR T RE TR RR — Yok
i = ¥ 12 Hb ht & R
*ACC EOH s
*B FOH I A%
*PSW DOH FEFRET
SP 81H HERRARE
DPL 82H HnAr i as TR e 8 42
DPH 83H Bl A it asfa bt 8 fir
*PO 80H W& 0
*P1 90H HiE 1
*P2 AOH HiE 2
*P3 BOH WiE 3
*[P DSH rhIRT LS g i 2
*IE ASH chT SO VE R A
TMOD 89H SE I 28 7 k4%
*TCON 88H JE I A
THO 8CH FERTE% 0 7 8 4ir
TLO 8AH SE I35 0 1% 8 47

BT | Lt | R | BEER | RIET | BN | R | M
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1 WA FEF SINEFEL

TH1 8DH SEIN AR 1 15 8 i

TLI 8BH SEIN 4% 1% 8 47
*SCON 98H HAT P2

SBUF 99H BATEAR R P 2
PCON 87H RS A SRy R

1.1.3 ERSHEEs

8051 F PHA 16 A7 AT i Fit s I 2%/ 40 8% TO A1 T1 LASZBL 2 I 1507 A b W T U RE e A i, 4% i
ANPBSLIY 8 AP AE RS L . TO PSS 8 A7 7574 THO A1 TLO P&k, b THO by 8 £7, TLO MK 8
Ao A TO Z[H, T1 A THI 1 TL1 FFM e, b THL A 8 f7, TL1 MK 8 fiz. THO. TLO. THI
FTLL 352 SFR Hr—A, HIJ™ al LR IR 45 e AT A7 O « PRIk, TO AT T i de Ko Eoiiqe ol 2101,
RIFFEE 65 535 Mk A BRI NA “0” B R4 “17,

TO F1 T1 A€ I # AR A TAERE, FEBR R X 4+ TAE T . fRE e, To A
T1 I vkE ik nl B 5 HUS BTk 22 12 23 SRS 240, 0 IR IR TRD A5 7 BN B AR A OC o R T RSt
AR, TO AT vty LA P3.4 1 P3.5 510 i .

X TO FTL HEHI P 8 SRR I RE AT AEA 50— NRR A i 2% 07 ik B 27 42 4% TMOD, H T-#fi e
ST I A TAERAGE S TS TR 50— ANFR A 2 I 8571185 /745 TCON,  FH T a2 I 4 sl H 2%
A B A5 1k DL R AT Hh 42 i

5510 T KX I s/ U AR A VR RE— R A 48

1.1.4 478 0

1/O i B Y i /O 1 B 1/O i, & MOS-5 1L AL A3 SELE i G A He ) b 22 2 #% . 1/O i [
HHRATRIHATZ 45, BAT VO i 1 W AeAL3% R —3EHIE 8, JEAT VO i O — IR ki —4 G B
MCS-51 LML PO P1. P2, P3 %5 4 A8 AL AUH 1/0 it I, 4k 1/O LRABAES T Hh B AE 4 A Ffar
H TR T .
o PO Ui F1: PO Sty L1 45 M W B 1.7 B o F i P A 3 — N0 S HE A7 B R A — S B NG vh 2%,
FANEAT AN B RS A R . XA IR N CPU AN B AE ik o SNSRI A7
A VO PR RGN, AR PL. P3 RFE R  tom . % 8 M # hImOT i, A
SUBRT CABKZ) 8 A LS 24 TTL Sk H N b B, AT 4 b Dh B I 78 e 20t 4 B C1OKQRIAT D
FFEPATHONIORE, D2 T BE % TR AN B s A RGN AT A%, ) PO
A AR R 2R (AO~AT) Rl fgk (DO~D7).

b/t i) Vee

o
V P0O.X

P
POX P
geirrm | | R | | =—o1—— ™
D> O MUX

BRI

K 1.7 PO i A 4544

3| L | R | AR | T | BN | R | I
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1 EWHTFETE SRFETFER
o PIUHIT: P1SEITHIM LI WIE 1.8 P, P18 THEXU S [, 45— T e X i A oy
HOSR O, SRR T, BB, Q=0, T2 #ub, W ERrBg AR 17, % O
H 1 40 AR, Q=1, T2 S3l, #ithh 0. MENMAMIIN, SFRE 1, Q=0, T2 #ul,
S 2 B T LA A0 L B B MO PR S, A1l A e B R . SRR I, AR R
A IS A P A7 2

VCC

BRI

[] it il
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WAL
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et | o] P# o

L)

K 1.8 PI i H ¥R

K 1 ST B A 2 BT AR S TS BB A R, SRR AR R B S A, IBC G RN
CPL (HUJ<). INC (). DEC G#ifl). ANL (L5i#45) 1 ORL (Z#Hmk) s 418 TIX KAk,
i3 P1 i LTERIRAS AT IF =351 G2 B AMRE A CPU.

o P2uiill: P2 Ui I IALE AN 1.9 Fiow, HREEZE IS PO S IAHAL, fH P4 30kQ Fhy B, $hAT %
H DRI AN RSN R SNSRI BAIKS) 4 4> LS 24 TTL $adk: # ZHATHATIRE, LA
HH T BE R LT I AN B s 37 R IE AN A i ds i b bk 2R T 8 4, T P2 s w]
Vel B2 (A15~A8) Tl

VCC

BT Hihk $EH

|
WEEL | D o | == —
P2.X O MUX
ghites | | WER )

>
| L
eI
B 1.9 P2 i A7 454

o P3[: P3 i M AN 1.10 Fron, AEAT 30kQ B ABH,  SAAT 5t D Be N AN IE B A L b
BELs % 8 AL AR IS it RS AT LAOKE) 4 A4~ LS Y TTL fa8; A EhATim A Thae, 25k
i Y BRI ) PITERE A

[] e e it

Ql

Ve
PR pes
55 T DR
[ Pt
|
WEEL| D Q —
P3.X
GHiFS | CcL S LA ()
| L

I
" TJ ' !
el 5\ IIAE

K 1.10  P3 sm DI 450
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Y. .
_Z TWHRFEE SRR FZR

FESZBR YA, P3 S S DR N R, 3R 1-3 B T P3 S R A T RE

#z13 P3 i ORI — T &
P3 i O BY{L i) I PE N -

P3.0 RXD A AT i i
P3.1 TXD AT HR K% N
P3.2 INTO AR 0 F A
P3.3 INTI AN 1 fIA
P3.4 TO TR 0 TN
P3.5 Tl R E BRI YN
P3.6 WR AR S S A
P3.7 RD AN AF i A AR

FEAS 1O iy NS —AS 8 AL s B E s Al — A 8 (Bl NG, 4 AN Ed i Bl A7 4 -5 s 1
5 PO. P1. P2 FIl P3 [A 44, #RERFRIIGERTA7ds. Rk, CPU s NIFAT 1/O i 1 4y H I AT DAAS 30 B8 A7
Hadm N oy LA B2

4 ANFEAT VO i PR IE ] VO i AT, A 50 0 e RS 3 AhigdE oy . S 0 sepr b
UK AR, 2N BN A SR A7 A RO AR 0k B B A T, ARG e 1 B Mo 15 2k E
s S AR ELIE M SN NG, TR B e RO B2 B CPU I BN s A
SEELIE VRSN BEE G ERE, 2 Mo 15 12 Eise NAMEB r  A\2dls .

1.1.5 1T H

8051 7 MEXU LRI g AT 1O 31 AT TO it T RE ] LAEREFFH oE CPU R 8 7 4T 8E A8 %,
HATEE O — AW AR TXD Rk il 25 T PR R A TR B AR 1 8 AT EdiRI%4S CPU, 1Ml
HIXFPERAT ACEFN FRA TR AT LA T, ] BATR] IS A T o

8051 HIAT AL ERATHACRI A T P3 i (W58 —DhRe, RIRIA P3.1 5IIE A SRATHIE 1) k%L TXD, H)
F P3.0 5 EIME N AT HGE 2k RXDs, W36 1-3 Fion. AT VO i F1IR HLES &5 M0 00 48 FR AT il 4%
SCON. FRJ§ K Fr Hik $E 27 4745 PCON AT EE S 4745 SBUF 55, XLEF 280 I8 THRF IR D e 25 A7 4
(SFR).

JLr PCON 1 SCON T3 & HiAT U LAE 7, ff e Bl (0 R s i dalopie e %, AT 8l gz i % SBUF
AR TR R 3% 8 CHM A . SBUF SERR b p W ANAH T AT ) R I8 25 s R R v 2 AL, 2R
R AE1£ 3] SBUF B, HEREARIEZEMA: 2N SBUF S8l i, WIE gz b a8, BUE M2
TR 8

1.1.6 HHREGE

8051 [ KT R T LAEESZ 5 AT 1) HR Wi (1 s i ok, ax 5 AN ITIRED 2 ANAMEH BT, 2 AN e I 2815
AR 1A ERAT T

AR R TR = AR R TR W SRS 5 RT LA P3.2 T P3.3 SI BAAN, A R EOA T A il O s s b
J5 TO A1 T1 MBS R IR AE LN A 17 A8 4 €07 i i B sh i b R s PSR ER AT DR IR )
T SRR FR AT PR AR 58— A 8 A ik s s R — AU AN B (8 £ J5 A Bl Il i T RGEER
8051 I HF W 22 45 3= % i IE (Interrupt Enable, W SRR il we AT ep WA 0 e 2 il 2 TP 25 o % 41 1. JLvf,
IE FH T4 5 AN b e ch s L6 b i sk 4 A0 V0 1) CPU M, BIRG rh s i) h s sk e 2 1k, TP T4
5 AN T IR BT SR AR e 2




EWIBFEE SIHEFER

1.1.7 Mgk

MCS-51 ¥ L MR gy, R bt Bek . B Bek s mngss 3 f, HIhfen F.

o MihERZE (AB): MBHERZLSEE N 16 £, 1 PO Ui 2 HbE B AR G 8 7l (AO~AT7); P2 i
T E et 8 frithhl (A8~A15), Muhk(E 5 & H CPU & H I H 5 {55,

o HiEZk (DB): Al BLkviEh 8 4, FHTALIEEWE R4, | PO a4,

o IEHIEZ (CB): BHEHEHR S IAFIPRA, FHARME T5 2 A OGR4

FEVT R ANEAE A s, P2 uitg Iy 5y 8 Az bt PO i 4K 8 fzibhl, | ALE CHBhb8ifF i) 5%
B PO i 1 bk s B2 1K 8 Ar Bl A7 RSN IE B S, TR PO iy 1R BCHH e 4%«
FEVI RSN EBTE P A2 a4 2 1), PSEN (AMIFE P AEAf a bl ) 5 5 A &L TEVT RSN SR A7 315 21
i P3 3O (A58 E (RD/WR ) {55, i PO #4110 A SR (i 58 8 e T 1 B A

1.1.8 8051 Ky /5|

7E MCS-51 YA, SANTS W 5 F MU B AR, HIEs [ HThRensa 257 . W E B 21
8051 X ol 1.11 ow.

-/
prog!1 40 A Vee
P12 39 [0 P0.0 (ADO)
P1203 38 O PO.1 (ADID)
P1.304 37 [ P02 (AD2)
P1.405 36 [0 P0.3 (AD3)
P1506 35 [0 P0.4 (AD4)
pPreQ7 34 1 P0.5 (AD5)
P1.708 33 [0 P0.6 (AD6)
RSTO9 32 [ P0.7 (AD7)

(RXDYP3.00 10 31 [@ EA/VPP

(TXD>P3.10 11 30 @ ALE/PROG

(INTO)P3.20 12 29 A PSEN

(NTD P33 13 28 [0 P2.7 (A15)

(TOOP3.4 0 14 27 0 P2.6 (A14)
(THOP350 15 26 0 P2.5(A13)
(WROP3.60 16 250 P24 (A12)
(RD)P3.70 17 24 @ P2.3 (A1)
XTAL2 O 18 23 [ P22 (A1)
XTAL1 O 19 22 [ P2.1 (A9)
GND [ 20 21 [ P2.0 (A8)

1.11 8051 5| HEFI K
40 255 3L R rYs g . o 28 A S A Y S R 3 38, HAR Dhae i s .

1. HIHEZE
Vee H+5V HJEZE, GND ek,
2. WAk

. m%m:mmmﬁﬁﬁmﬁm ATEVE N “1” AR add, HEm A . PO S B AT LLAED)
[ AR > A it IR A B PR AR 5 5 AE D7 1) S0 8 s A7 it s IV bl B e RIS o pAY s %3k 17,
e P1yil: Pl ﬁﬁ[]ﬁ%ﬁ?ﬂﬂﬁﬁj;fZE@XXF]IK)im[Jo ] P13 U5 N 17 I8, P g 38 bz e v

[IDAEK{ WA B E(EW/SE naRY. i 2 SHIE VA (i B W A WA PR /S i o AT i v

it:  www.farsight.com.cn
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LU HTFEE SIWRETER

o P2 it 12 P2 5ty A A B _ B2 80IA) 1O 3 1o 7] P2 St 15N 17 BF, P2 3ty 4k P98z v P,
ARSI NS o 24 R s, AN R AR P2 i 1 2 IR kg 3 e tE R . AE VT IR AN R
AT AR AN ANER B 43 SR Ry ok = 735 16 A7 ik (MOVX @DPTR), sl ik ooy i ALt 17,
A 8 Ak (MOV @R iy I AMBEAR ALt IF, P2 3iig 0% P2 ek DB 27 A 11 N 2%

o P33 P3 Ui EA A EE ER LR DO 3 1. 1] P3 S SN 1, P3 i g N BB bk m e,
RS NG o AR R T, B AR P3 i 25 DRk b R . P3 s AR | S
ZATHILEE —0hRe, Wk 1-3 Pios.

3. EHlEHALEER L

o XTALI Fl XTAL2: Jv 45 AN o XS5 [T SR A M A o d AR RO Fe 2, B SR I 8051
7 OSC B5E I st R, L XTALL #2a F A S i N, XTAL2 #& it dfi s vl LK XTALL
e, XTAL2 BAMBHRG 55 DAL MCS-51 Frifs e, HARR AR B 1.2 R 1.3 o

o RST/VPD: ¥k #Ia AT, 7Rk A F I PR AN ALAS A v P CHAR R =gk, R LA
RST/VPD 55 —IhAEAEAE A 2 P IS A NSt o M3 YR Ve B AR WO i BRI B E A FE P, RST/VPD
2 )& IR A, DURIE R P RAM TR 5 BEAS 5. i, 8051 IR A B LHE A
NIRRT RN, g 112 (2 FME 112 (b) Fis.

Cl C1
22uF 22uF
+5Vo—] RST +5Vo0 1 RST
\—:l—al_
RI C2

1kQ 2002 R1

1kQ

(2) BRSNS (b) AL LI

B1012 MCS-51 FIE A7 L
e ALE/PROG: HuwhM8ifr/gmfEsk, WL PO i L2 —DhRef . 7E U5 M ANERA- i iy, b ko B A
HERMR T . EIEHTEOUT, ALB A5 5 16w 0 1/6 3 A% 5 ] ARSNGBl e N o 33 B R n)
ANERE R I — A ALE Bikeis gl 200
o PSEN: FR/FAEMHARE, BAMTRETAEAf o 9 NAMEB LR I, PSEN SRANHLAS 8 HIRE 0E W X, PSEN
SUR AN R P AL A A S hIE L, R TSR A7 6 45 R SRR P A At 2 S AN AE A o
o EA/VPP: AW RE/ AR B o TRV 0 3EAN SMIRE P A2 i 2R ) EA A2 AR EAIC

1.2 MCS-51 BRI RS

FLFHUN HT R G5 AT A — TRATT I O HRE AR S5, e SR TR RS RE/y 2 Se AT 55 4
FERJEAAE, Sl — 44 B HLRE VOISR 418 . — BRI RIS RS, mimk
THRL R

1.2.1 8051 KFF&#&=

LgitES 2R R BEAN B G, mIncsr. HRES. SRR A&k 113 fror:

bR BRAETS BEsL R

B 113 JCgmIRLm—mos =t

www.hayj.com #RATUERE: www
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LU HTFEE SIWRTER

b5 (LABELD 52 R GO g R 75 B245 18- W€ AT 5 ik, FRic i ATHR - AER e A AL R, T Al
brg AT LR DRSSO A RETF KK B SO AR IR AT S P81, i 1~8 DN PR 4R AR5 n i §
To HHEIRS—HIRTART, WAEI AR iR 2 b B nT 5T 5 4 ik

#:4E1D (OP CODE) HIRFILIRLMIRAEDIRE. W1 MOV FURBdifEi%484E, ADD RO IEBRAESE,
BAF % (OPERAND) JE# A5 Fr 2EAL BRI St , 2T AT, VERORRHR2 MR, T A
REFFIIPT M, D5 B B B 2. TR AT AT 5

1.2.2 8051 HFak =,

BAFEOE TR R A BRI, 5 T 2 5 3RAE A s ik . S PR Bt bk 1Ky SRR ks
N AR R AR FhE T 202 IR 2 I TIREJUE I 0k )5 S0 $5 2 ThBE Ao .

MCS-51 B P FA R0k, EEeTak. SZAISaE, RSk, SRR Sak . A SHERIAr SEAE 7
P k07 30, NI 7 Bl B AT R A

1. FHEHFUTRK

8051 W RAM [REAS TAEZF Ao Iy 8 AN 75frss, Ml RO~R7, #AE¥U#H RO~R7 8¢ A. B.
DPTR [$54 - MR AP 7 A7 88 -0k 7 5. il

MOV A,RO;A < (RO)

CLR A ;A<0
84 “MOV ARO” FIFE 2 RO Zi A7 g8 h I Bs L6 2 2 nds A b, HAERERU7 B 794748 RO 1, BT
PLN AR G0k, WRFAE2% RO HH N 20 20H, WHATHRA 5, Shnes A s As 4 20H.
§4 “CLRA” M/ 240 F 5 Ar 2 AN 2052, HAREECh A, Pl 2 F A S0k, $irasd
Ji, ATHIER 0,

2. E&EIHTK

BT ELRSY M ERAE RO IR Tk T3 K BEREAT B S IR A% 2 (I AT SFR S 745 MU 9 RAM 1) 128 4
o, Bill:

MOV A,P1; A< (P1)
MOV A,33H ; A< (33H)

84 “MOV A,P1” IFERTZHE SFR ' P1 i TN IE A F7842 “MOV A,33H” [/EH 2 RAM ik
9 33H A7l FR T N 26 A
3. MEIFHET R

BT ELRSY BRAE RO kD 2 SERIERAEBTI AT oAy “#” 1) 8 A7 sl 16 ML AR, LADCH T E#%
ke SERPEAE SRR R REA U SR L, LS IS (R D RE A if 4 ROML. il

MOV A,#30H ;A< 30H
MOV DPTR,#1234H ;DPTR < 1234H
MOV 33H,#40H 333H # 5 < 40H

EFAER: www.hayj.com #BARFER: www
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LU HTFEE SIWRETER

ik 3 A8 HUTEE, Binge A TPEdE b7 B4 30H, DPTR ZifEss i 3di A 1234H, 33H oo 3k
S BI#L 40H.

4. [EEEFHF K

TR )BT U SRR AT TR B A SR T R BT 25 A7 2 o, F72 b UG 3 A7 . PUTHR 20,
TR 2 A7 s O A AR B I A S A R A Rt bk, P it IR B ERA RO 58 AT N R AR, B

MOV RO, #30H
MOV A,@RO
MOV DPTR,#1234H

MOVX A,@DPTR
XHFEA “MOV A,@R0” Al “MOVX  A,@DPTR” #J2 %5 A7 o 114 3-3ik, HA I 43 59 S 45 1A 3 5 s X
30H o0 BB A AN BOE X 1234H FoC B EEREAN Bngs A H.
¥ 30H oG i & 23H, 1234H FooHP 8 /& 90H, U 45484 IPAT 1RE 12 S A7 fiff 5 TG ) A 2%
Sy 1.14 (a) 1 1.14 (b) Fion:
F A RAM J 4 RAM

RO 30H DPRT 1234H \
30H 23H 1234H 90H

A 23H A 90H /

(a) (b)
K 114 (g Fak s SO EIE
()% - 1k FR M bk 23 [A) AT PN B A7 2% ) 00H~7FH Fil A AN R 474 24 1) 0000H~OFFFFH. [a]4%5-hE/)
A AL ROVR1 Al DPTR, [HJH - HEWS Z3E [ 4 Uk A A2 wi iom EfF5“@”. i B “MOV - A,@R”
Al “MOVX A@DPTR” 54 .

5. FhbARhkF a7

FENEASHE G RN A AR (A) SARHEA RS (PC B DPTR) (KN ZAHNN, 45 Ak g B vE 5 sl ()
FHET7 e AT R BRI AE A P AR AT, B TR A A e B, Rk ik A
BAEME S 8AE, R4S 2R Move B, &XRhhk )y L2 H At RA R Sukr
BAEMIR A3 3 4

MOVCA, @A+DPTR

MOVCA, @A+PC

JMP @A+DPTR
1584 “MOVC A, @A+DPTR” HI/FEFI 24 2 hnds A FIAZHEZF/74% DPTR I ZAHN, AINS: BAF A B 8T
il R PR E RO RS B BN ES A s FRS “MOVC A @A+PC” 555 Fa ML &
WA ZF A7 T PC, HAIRAE 55— A $84 “IMP - @A+DPTR” {15F2 /B BIFE A7 Gt 4
thihE ol “A+DPTR” (M7 kS0 T
FRA2“MOVC  A,@A+DPTR )7~ = BN &l 1.15 o, AT 211 A A 250 10H, DPTR FI{E A 2000H,
MIHATHES G A HFAERT FEF A4 25 i ikl 2010H FAEA% M, BN 64H.

EFAER: www.hayj.com #BARFER: www
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TlwTEE SHRTZEZR
e
DPTR
2000H
A
10H 4~ 2000H
— 2010H 64H > 64H C(10H) B SPa

K115 SehkA kS akT7 5

6. X FHTTH

AR S0y O DU TTRE P oA PC A kA, I AR 2 I — i AME AL (WA D TR RO
PC {134k J7 30 AR G T PC A, TZM TSEOUREF I3 iz . il

SIMPOSH ;PC+PC+2+08
RS W 1.16 Fros:

TP 170 4
2000H SIMP PC
Ny (2000H)
08H w1 e
08H N 2000H +2 200AH

A

—» 200AH

116 A0S HET7 50

TR B UL IR, AR TGt 5 A D A EBORAZ DLEAR I 08H 45 ik, 1T LA— A5 Hihik g5
XA Mk R RS B ) 4 BLHAT IR 2 0IAR S o br T I B AR AR AT g8 5 R 7 17 G
b FE R B RN B B R I BUE R 7 Hh 45 RIS 75 k.

AN, AT N S B E R VS AN 128 ~+127, WLV TR A T — 495248 —ANE A i k-
EEE,  [BIBk 128 AN T EE Rk 127 AN TR TG,

7. ALFAETT

P T HE R AT AT B T HE AR, T EaR A2 )48 2 AR 2 4L AT B SR A A2 MCS-51 R HLH,

ERAEBCA T DA 7 BT BEA TR, o mT DU A T HAE

O AR RO, XA R RO R Oh A il . A Sk X R L T T 2 HEE A RAM R AN
X4 — AN E RAM HIAG-0EX, HuhkEya & 20~2FH, 3% 16 > RAM ¥.o¢, fiibhkh 00H~7FH, 3t
128 Ml —RRFERIIRE AT A7 4% SFR, 11 ANF5Aras, LMy Fak, sk 1-2 fros. #ildn:

CLR 00H

ANL C,5FH
1E474 “ANL C,5FH” w1, SEAZA7 C A AIHRAERIAL 2N s . $5-2HIDhRE2 4 SFH AR S HERLAL C
M5, HiRHE C o




FY. . .
1 LWHEFEE SIRREFZL
LERE AR, RG] DU L4 . BIIIF5 4 “SETB TRO” 5 Hk 1A% % 77 4% TCON H1fy
TRO CHAZHhER SCHY # 1,

1.2.3 8051 K354 A

8051 FL A HIALA 111 4454, #IIREnT LA AHURILIETR A (28 450 HARIBHIES (24 %), 2iREH
74 (25 %), AiffEfR A (17 4% FEEGFEER S (17 %) FI&RLA s mE .
Rn (n=0~7): L/RMETIEH M) 8 N TAET /748

Ri (i=0, 1): Foxung el HT 8 A bbFe e A TAE T 478 o

direct: #7n)7 P RAM (00H~O0FFH) B, SFR [X [ B # -k .

#data: Ko~ 8 N HL.

#datal6: 7R 16 A7 4.

addrl6/ addrll: FoRAMIREFA-AE AR 1K) 16 A78% 11 A7 Hhk .

rel: Fon 8 AimAEHudik, BRSO BeES (0 s 7

DPTR: %75 16 A iiEda%t.

bit: Fos EFEATHHE

@: FORMEET AR TS

[+ FORATERAE IR TS o

1. BEfeika<

HAAEILRIRAIL 28 4%, SRR IR R BB . RS PUTIS, JEEREEONAE,  H MRS R
ERAEHONAR

B L5484 MOV, MOVC. MOVX. XCH, XCHD. PUSH. POP, 3L 7 F.

(1> MOV (Move)

MOV 82 BTG, VIRAIEECNE, BB EEIE SO % H B EE AR, nT R MOV
/40 HEL R L.

o VLA NHMEAEE, BAMIEAIE L2601 W3R 1-4 Pios.

Fz 14 LA 75 B RUIRAEEEY MOV $5 4
iC % & 2 I B 2 RIER
MOV  A,Rn # Rn PRIEEEN A R MOV ARl  ;A<Rl
MOV A direct B E A direct TP AIEEEN A R MOV A,30H  ;A<(30H)
MOV A #data ¥ 8 AW HUIEN A MOV A#40H ;A<40H
MOV A,@Ri B Ri $87R G HRE R AN A MOV A,@R1 ;A<(R1)
o LURn N HPERMEE, BARRFRSTEA A B IR 1-5 Pros.
Fz1-5 LR 7 B BYIRAEEED MOV 154
iC % & 2 I B B2 RIERE
MOV  Rn,direct B E B direct HHEUEAN Rn H MOV RI,24H  ;R1<—(24H)
MOV  Rn,#data P RIBOZEAN R H MOV R2#30H  ;R2<-30H
MOV  RnA A HIELEN Rn H MOV R1,A ;RI<A
o UIEBEMME (direct) 4 HIMERMES, HARRFRS A5 1-6 Fiox.
F*=1-6 DIE Bettbit 4 B B9iRI(EERI MOV 35S

. www.hgyj.com AR www.embedu.org  1EdEEEBE:  www.farsight.com.cn JEE | L3 | R0 | AR | R BN | mE | M

e www.3g-eduorg PIEEMEERR . www topsight.cn &8 BiE. 400-706-1880 , 15010390966




1 FY. .~ .
WA FEF SINEFEL

iC % & 2 R 45 R 7%
MOV  direct,Rn ¥ Ra P IWEEEN direct H MOV 24H,R1  ;(24H)<RI
MOV  direct,A ¥ A TN direct MOV 34H,A :(34H)<A
MOV  direct,@Ri # Ri fRR S e I EEN direct HY MOV 34H,@R1  ;(34H)<(R1)
MOV direct,#data P r BIEE N direct HH MOV 72H#04H  ;(72H)~04H
MOV direct,direct B —A direct PHIFOENS — direct ' | MOV 34H,23H  ;(34H)<(23H)
o UUuEHsNE (@R N HEERAEEL  BARRIFR-S TR A B ik 1-7 Pros.
x1-1 LAE) #EHR 4 S B ROIRIESED MOV $5%
iC % & £ I B B0 R 7%
MOV  @Ri,A B A FIIEGEN Ri FRoR L MOV @R1,A ;R1)<A
MOV  @Ri,direct H direct FIFUE AN Ri $FR7R 0 HutikH MOV @R1,22H  ;(R1)~(22H)
MOV  @Ri #data B SrEDHOEN Ri FE7R G bk A MOV @RO,#16H ;(R0)~16H
o LUDPTR Jy H #RAEE, X2HE—1 16 fr B RA SR 4, 48 16 A7 HUE AN DPTR. HOB Lzt

¥
MOV DPRT,#3000H ; DPRT < 3000H

(2) MOVC (Move Code)
MOVC AP AR FE4S, & H DPTR AL LRI P A4 o I B il . MOVC #8447 L I E A%
2
MOVC A,@A+DPTR ;¥ UL DPTR H3kht. A NfR# bt 69 B#EN A #
MOVC A,@A+PC;# LA PC Ak, A N MRt N EEE N A A
54 “MOVC A,@A+DPTR” ({1 £ £ uH 0 IA ROM 1] 64KB #%[f], 54 “MOVC A,@A+PC” HAer k45
A Ak LIS 256 545 i P 0 SRS o
(3) MOVX (Move External)
7E 8051 FRA AL, ViR o RAMUARES Bnds A Bi&HFFAasE 30, B “MOVX @Ri,A”.
“MOVX A,@Ri”. “MOVX @DPRTA .. “MOVX A,@DPRT” % 4 4154, H 4 RAM 54 1 AR 5L
hiefzsplank 1-8 fior.

*z 18 RSN RAM 78384
iC % & % I B B RERE
MOVX  @RiA B A FIIEGEN Ri FRoR L MOV @RI,A ;R1)<A
MOVX  A@Ri ¥ Ri fan bk AN A MOV A,@R1 ;A<(R1)
MOVX  @DPRT,A | ¥ A *PH%0% N DPRT $87m (1 bk MOV @DPRT,A  ;(DPRT)<—A
MOVX  A,@DPRT | ¥ DPRT $E/R [ HhE A IBOEN A MOV A,@DPRT  ;A<(DPRT)

(4) XCH (Exchange)
XCH 5238740, P A m) B B E R 2 Bnds . XCH F52 1 B AR 2L Dhfeizs o n &

1-9 iR
*19 FHRIRIES
iC 42 I He O
XCH  ARn A IR R A 428 e XCH ARl ;A<—RI
XCH  A.direct A AT direct H I H 428 i XCH  AJ30H ;A<—(30H)
XCH  A@Ri A RECRT Ri FRR B0 R B4 A XCH  A@Rl ;A<—(Rl)

(5) XCHD

U0 | R | wER | BOX | RE (|
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fFAx HGHTE LU HTFEE SIWRTER

IR AN EEAEROAR 4 47 B3, T 4 ALAAE, KA R i—RE .

XCHD A,@Ri ; AT EECR R T BT B R
(6) PUSH 5 POP
XA FR 2 e MR BAE TR 2. PTIRHEAREAE AP RAM i “Aeilb gy, Jadtse” IR e & (1 & HI A7 i
X H AR A HFREE SP e B, W] DUEATE M) BRI N 2 s AN HERR, 045 SFR, B A]T LA 2R
s By PSW R &Rl {426 27 £ 2 TR A HERR . A 0T DM RO~R7 4 TR N R AHERR, ALK
A PSW PR 2 V)4 TAE 25 A4 4

X AR B S
PUSH direct ;SP< (SP+1), (SP) < (direct)
POP direct ;(direct) < (SP),SP < (SP-1)

T T E I AN R 5 I H i A e A 1 HAR RN H
[ 1-1] % K W RAM 30H .05 40H FocH il i 25 B 4.
Tk HEshh ALV, EH RSk 31H, AR

MOV 31H,30H ; (31H) < (30H)
MOV 30H,40H ; (30H) < (40H)
MOV 40H,31H ; (40H) < (31H)
SIMP $

D7k 2: [l IE T, AR
MOV RO, #40H ;RO < 40H
MOV R1,#30H ;R1<30H
MOV A,@RO ;A< (40H)
MOV B,@R1 ;B (30H)
MOV @R1,A ;(30H) <A
MOV @RO,B ; (40H) <B
SIMP $

ik 3 E A AR IR, ARAS R
MOV A,30H ;A< (30H)
XCH A, 40H ;A< - (40H)
MOV 30H,A ; (30H) <A
SIMP $

J7ik 4 HERRARIRTE, AR
PUSH 30H
PUSH 40H
POP 30H
POP 40H
SIMP $

2. ERIBHES

MCS-51 WA S ERIESEIG S, WL InE. wmak. TRk 4 K. A msE
RIZFHRZE 8 AL, BRT N1 FIYE 1 454 HAR I FAGZ H A7 2 HA 45 A8 3 B onas b, 756 2 h s
KR A 2R M bR A
(D ImEie4
INEFRAA 13 4, miAN CY DINEFRA . 4lr CY IEFa AN 1 F5 25541, A4y CY BIi%iE 44 “ADD
ARn”. “ADD A, direct”. “ADD A #data” 1 “ADD A,@Ri” 25 4 4. AN CY I 2 BAk35 Ak .
IHEERAS I LI 1-10 Fron:

%110 T O BnskE S

13T | L | R4 | AR | RO | BN | R | M

EFAER: www.hayj.com #ARFER: www.embeduorg 1EdkFEE: www farsight.com.cn
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_ZE.TZ .
WA FEF SINEFEL

iC % & < I HeE Z#HIRER
ADD  ARn Ro IS A RN, 25RAE A ADD ARl ;A<A+R1
ADD  Adirect | direct IES A FHIN, S5HRAE A ADD  AJ30H ;A< A+(30H)
ADD  Apdata | LEDELE A AN, AiRAE AT ADD  A#30H ; A—A+30H
ADD  A@Ri | RifE/RmIcHhmst A, 4587 A b ADD  A,@RO0 ; A—A+(RO)

W CY MNkiE 44 “ADDC A,Rn”. “ADDC A,direct”. “ADDC A #data” fil “ADDC A,@Ri” % 4 4. 7
CY HIIEIR AR, DhBERIZS GBI 1-11 FioR.

=11 & Y BnEiES
iCL % & 2 I B 2 R TR
ADDC  A,Rn Rn HIECE A FsERI AR, 45578 A ADDC AR5 ;A<A+R5+CY
ADDC Adirect | direct "INES A TrdEAAHM, 45 RAE A ADDC A 37;A<A+GBTHHCY
ADDC Afdata | SEPES A W AN, 450R7E A ADDC  A#56H ; A<A+56H+CY
ADDC A,@Ri Ri FER e S A f BRI, 45995 A ADDC A,@RO;A<—A+RO)}+CY

14844 “INCA”. “INC Rn”, “INC direct”. “INC @Ri” #I “INC DPTR”, Jt5%. 154 M4R4
S DHRERIZS B 1-12 Pros.

* 112 1%
iC 46 % I B 245 R i E R
INC A A HEIEON 1 INC, A JA<—A+]
INC Rn Rn H &0 1 INC R4 ; R4<—R4+1
INC  direct direct " %N 1 INC 34H ; (34H)<(34H)+1
INC @Ri Ri fig7n e o 1 INC @RO ;(RO)<(RO)+1
INC DPTR dPTR %N 1 INC DPTR ; DPTR<DPTR+1

R A A I R R BA T 3 /MR

o BNUEEE A EREBUL SR 8 7 BEHRIB0 S B2 — A 3R

o FHPBEWT DIARYE gn B2 75 20 2 Has HIN MR TESCE 1E 2 AT 580 (0~255), o n] DL ILE 1E & 75
FHC (—128~+127) 0 ARIEXIN SIS H W EAEECE TR TEAT S HOL W55, 50 L 4 Ry
PP BUENAT IS E I 74 PSW IR .

o FWS IS H IR EAEECE ME LA 550 WINARYE CY W2 Hd ki s #0045 2 s S A8 E
BOEARATTH, WS 545 R NS OV 47 K H W .

(41 1-2] AFEAE MIM2 R M3M4 H A 16 AL BN, 85347 T M5SM6 1, Bk 3 AN =i e
Al FEPUWIE:

MOV A M2 BUE — BBy 8 A

ADD AMA; 5% AR 8 A, ZRAEEAT

MOV M6, A ; t- 75 BT 2k A By ik 8 £ 2| M6

MOV A ML EUE — B 8

ADDCA, M3 ; F 41 #175 8 Al n, B 8 fAl A b By 2o fir w2t 5k

MOV M5, A {EAE fn & 8 frfE A M5

SIMP $ S
(2) JiER4S
LR H 8 4%, WHE CY MyEFRA R 1 822K, f CY Mk ss 24 “SUBB A,Rn”. “SUBB
A, direct”. “SUBB A, #data”. “SUBB A, @Ri”, 3Lt 4 4. i CY HIIEIE A MM . ThREMZE] 2
1-13 FioRe

=113 B Y BRCEIE S

L4 i % If e 20 KRR

0-706-1880 , 150103909




FY. .~ .
1 WA FEF SINEFEL

SUBB  ARn Rn 1S A T BCEELI, 4RI A SUBB AR5 ;A<A-R5-CY
SUBB A, direct | direct I A FHIEGTEAL, &HR7E AT | SUBB A37,A<A-(37H)-CY
SUBB  Atdata | EIECE A PROECHI SN, S45HE A T SUBB A#56H ; A~A-56H-CY
SUBB A@Ri | RifaRsicHiscs A b i i 4 vk SUBB A,@R0;A<~A-(R0)-CY

Ik 1 F§2LFE “DEC A”. “DEC Rn”. “DEC direct”. “DEC @Ri”, 3t 4 %&. W 1 {82000 TiRe
FIZEBI QI 1-14 FoR.

Fz 114 W1iE%
iC % 18 2 I B 2O RIER
DEC A A TIER 1 DEC A s A—A-1
DEC  Rn Rn FFHIHE 1 DEC R4 ; R4—R4-1
DEC  direct direct H I EIE 1 DEC 34H ;(34H)~(34H)-1
DEC  @Ri Ri fa7n oo i Eok 1 DEC @RO ;(R0)(RO)-1

TEAE FHRIETR A MR LR 3 AN,
o {EMCS-51 H g HLH, HAANW CY MiETES . BAAHAT CY Bk 2, W RAFEA LM CY 11
THIEFR A TP H — SRS CY BI$R2, 2w

CLR C D CY uEE
o FEHLR ML, WEHRAESLRR LR AE g i R R AN ISR SEB ) o AHAESEBR N A, 25 B A
Wi AR e 4 5, ATy mT 42 B 24 T
e SUBB 5451 PSW, 1fiif DEC 54 A5 PSW.
[ 5] 1-3) HAFAE MIM2 GEfigERTD FPIR—A 16 AT BAERUE M3 FF—A 8 M B, 45547 T
MIM2 H1, ZZFPUR:

MoV A, M2 ; BUBR 2K 1 1 8 i

CLR c ¥ CY fLEE

SUBBA,M3;A<M2-M3-0

MOV M2,A; &7 A3 E % 8 fr 2 M2

MOV A ML ; B AR 1 & 8 1

SUBBA, O ;A<M1-CY

MOV ML,A;REFRKZHE 8wz M1
(3) FHEHI R4
TR T A H AR I2 E IR A I 88 4, (Hoe AT e Hab g, xXFe, %A
8 i = A R/ 077 e 1 4 <A 1 - O A =t O 1] - £ R = A = R < Y 2 o i
BB . A T HRERIE T, MCS-51 B $ it T — 4 T RERIBOR TR 4, XA e 7 A
£ B = o 1 N P Y = 7 e (27 SO g =R ot M e S M o€ I 1= Ry 2 S Wy ([

DA A 1% AC=1 B [A3A2A1A0]>9, N A<A+06H

;% CY=1 # [ATA6A5A4]>9, M| A—A+60H

(4) FePritsa 4
Ty FIBRIEFR 2 %4, Teikiv Sl “MULAB”, BRIEFRAN “DIVAB”, HASADhaeng 1-15 frox.

=115 gL
iC % & 2 B
MUL AB A B TP S HHTE, SR 8 LAE A b, 8 fLE B
DIV  AB A, B RS HHER, BTE AT, REAEB P
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TUHTFEE SRRETFER

[ 1-4] CAIEAS 8 LLCFT 5 H o HITSAE R1 R2 A, KX AN BT IR IFHE IR =1 8 AL 30H 15,
% 8 AZJEA 31H o0, ZHRFAIE

MOV A,RL;A % — N
MOV B,R2;B—# - F#
MUL AB ;BA-AxB
MOV RO, #30H

MoV @RO,B  ;(30H)<B
MOV RO, #31H

MOV @RO,A  ;(31H)<A

3. BHEEHES

WIRIZ IR HAT 25 45, ATLUN A 8 AL —iF BT 5. B, JE. el HEs i, i ny PO —AN 7
WHHATRALERAE . XIS, BRLLEMSS A N BRI 24, HALTE A S 7E PSW.

(1) &4 “ 5”7 i27iE4

Wi “ 57 IR B S . w5 A 1, SRAN 1. B ST 88 RS
JAH “ANL A,Rn”, “ANL A direct”. “ANL A #data”. “ANL A,@Ri”. “ANL direct,A”. “ ANL direct,#data”,
L6k, B 57 BEARSHFRSKAL DIRERIZEHI L 1-16 F 7R .

%116 B3 “5” BHES
iC % & £ I HeE #  f

ANL ARn Ron IS A “ 57, 85R95 A ANLAR4 ;A<A/\R4
ANL A direct direct "PINEE A “5”, HIRAE AP ANLA30H ;A<—AA(30H)
ANL A #data SLHIES A “5”, SR EA T ANLA#30H ;A<A/A30H
ANL  A,@Ri Ri fR7R I IS AR 570 45 - TE A ANLA,@RO ;A<AA(RO)
ANL  direct,A A Fl direct HIEOH “ 57, 4 RAT direct 1 ANL 30H,A ;(30H)<—A /A (30H)
ANL direct,#idata | 37 BIECR directH A “ 57, Z50AF direct H ANL 30H,#30H

(2) &2 “u” BHIES

B B IsHIRARIEH <57 BHEIEASEM, HEE 1-16 T NIES ANL #efE “ORL”, i T
B CE” B 6 KR4 . N CE MMAMIE AN 1, SR8 1. @ Y8 BHEIEAT
A% ThREFZSFI IR 1-17 Frr,

=117 Bi ‘s EEES
iC % & % I B Z  f

ORL A-Rn Ron IS A M “87, &@5R1E A ORLA,R4 ;A<—AVR4
ORL A, direct direct TELS A FH “B0”, SHRAE A ORLA,30H ;A<AV(30H)
ORL A #data SLERES A A “ECY, SRR AR ORLA#30H ;A~AV30H
ORL A,@Ri Ri $E7RBICH S A M “al”, 4554 A ORLA,@RO ;A<—AV(R0)
ORL direct, A A Fll direct HHOHE “80”, 455AE direct H ORL 30H,A ;(30H)<—A 'V (30H)
ORL direct#data | 2 RIHCAT direct HPREAH “B17, 45RAE direct '+ | ORL 30H,#30H

(3) & “Ho” i

W a0 B ERSNETI RIS AR 2 REL HEHEEE 1-16 HIHES ANL #Af “XRL”, Sk 7 iZ
] CrE” B85 6 KRS, ZHEE 57 BREKANMIIAME, BI—Ah 10 —A4 0, 48R4
A 1. R e BSERRHR L DhREMAE IR 1-18 PR,
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y [O/F s LU HTFEE SIWRETER

=118 B “HI BEES
iC 4 i £ I B =  fl

XRL A,Rn Rn H RIS A “FEl”, 8504 A XRLA,R4 A<A®R4
XRL A,direct direct IS A M “REL”, RE AP XRLA30H ;A<A®@ (30H)
XRL A #data SLENEE A HH “RECT, SRTE AT XRLA#30H ;A<A® 30H
XRL  A,@Ri Ri R och i8S A M “ a7, 488275 A | XRLA,@RO ;A<A® (RO)
XRL  direct,A A Al direct HEAH “EL”, 45 RTE direct T XRL 30H,A;(30H)—A @ (30H)
XRL direct,#tdata | 7.RIECF direct " INEL “ B, 45 HAE direct | XRL 30H,#30H

“L5 7 a2 IR S IS LA B OR B R I R i AR A s Bl Ss S H IR A
TR E 1 “ R A AR AT IR R . X 3 MOZ s S R

(1 1-5 73 500KF P1 S RIS O 0 28 1 A0S, 28 200, 2B 3 0. S48 1, S50, SHefi. 57
Pl . ZHEREFUNR

MOV A,#OFCH ;A< (11111100),
ANL P1,A :P1<P1A(11111100),
MOV A,#1CH ;A< (00011100),
ORL P1,A :P1<P1V (11111100),
MOV A,#OEOH ;A< (11100000),,
XRL P1,A :P1-P1@® (11111100),

(4) BEnaigERM IS
E MCS-51 1, L1 7 BngsiEEM 2 NS BU 45 XA TR BN A 1 e 4. BARKH
BAALIE S E I “ Ro” BEIRAS W CURRIFEAE HE, (HE WMok e/ s8I Bmeass
E. BN IX TR 1k R

CLR ;e EEF MOV A,0

CPL s EEMT XRL ALA
(5) BAife%
MCS-51 BAR A 5 40T BNy A REFRIAT A EAEN TS, (B R T A4 0 8. BT 4
WIELLF 5 49584

A
A

RL A eV

RR A EAER

RLC A JHCY LEFEH
RRC A ;% CY LB H A
SWAPA SR AT AL A 41

5 4RI 3K BIPISR T A CY MRSLLIEA AR S, BINds A Pl A7 ARARLL A0 R
BAT AR JRIAAR AW CY ARGALIIER B BT fa — SRRSO 7 ide <, T
Snas A e 4 ARG 4 A7 IXA TR ThREWE 1.17 iR,

A
RL A:
A7 A0
A
RR A: A — A0
RRC A: A
A7 A0

RRC A: A
A7 A0

SWAP A: AT~A4 A3~A0
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U HTFEE SILETER

117 BALIR27m A

[ 1-61 %01 30H F1 31H *ICH AT —> 16 A7) —3EHI%, 30H H ok 8 . ZEUREEECRLL 2 517
FEBAEIX NG oo, RERR T — k. SE5BFuT:

CLR c ; CY<0

MOV RO, #31H ; BAEH K 8 {£3% RO

MOV A,@RO ; A-BAERME 8 {L

RLC A SRS BREMAY, B bW ALKAE CY #
MOV @RO,A ;3R 31H %7

MOV RO, #30H ;BAEHE 8 {11k RO

MOV A,@RO ; A-BEHE 8L

RLC A SRS BREMAY, REMLBNMNZE CY
MOV @RO,A ;% E 30H #

SIMPS$ ;A

4. EHIEBES

PR IR RAEMIR S RAHAA I — 5L, TEUSCRRAI 8l PC WA H I, DUESR S
FEFFRATHLIE - 8051 A7 LEARHATR IR 15 %, WIS KBRS TR
ARIEE S S HAEES, L4256

(1) T&MHERIES

XIS ILGWT 4 4
LJIMP addril6 ;PC<addri6
AJIMP addril ;PC<PC+2,PC10~PCO«<addril
SIMP rel ;PC<PC+2,PC+<PC+rel
JMP @A+DPTR ;PC<A+DPTR

F—RILSMAKEEIES, HIBEH addrle K MECT AP IS PC, HLE AT T 43R40
TN B addr16 PATRET o ¥ addr16 & —A> 16 A7 bl (HihkyE Ry 0000H~0FFFFH),
KA A A 45 4 1T LULE 64KB [WTE W He% o 4 TATRET 209 S , addrl6 4 K 45 Hihik (41 LOOP.LOOP1
) FoR. B R AR AR P AR S LOOPT [ /5 04T«

LIMPLOOP1
5 SIS TR H RS IR A . X 4354 HLAEIE addrl 1 UMK 11 73X PC B 11 47, PC HARHIE 5 52
5 PC I 1 PRIRJE ) 5 A, PRI R H8 4 0T LAE 2KB (10 [ P [ BTl n) 5 468 . [FIFE, addrll 4
A LR A5 ik
B RAR PR R R IR A, IR SEATRE P EES PC N 1 PRIk CEPECH 4205, SRJE4Em 1 Mik)E
e AT rel A INAE A H bR bl . J R 454 1 S b e R Ve J—126~+129.
FVUAKIR TN LN IR S . R PATHT, H P NS HAr B ik i 5 bk N DPTR, Hir#
i HE S I () S B TBPE BN A the ZEFRAHATIE, MCS-51 3514 DPTR S IR 2 n4s A
Wk kRS AN, DA R H AR R M i AR P14 PC. JlH, DPTR H bk 2 — AN e 14,
WK IR AR MR MG HE, BNE A PN R M S hE, S L A B RS R A 5 T sk
IR0 5 S %
SNV TR A R AR L — B R AT e . ARSI 8 4%, W BINEs A AR L .
FLAS SRR Rk 1 4568, L 3 24,
(2) Bhn#s A A T4
XYFR A PAT I LA B nas A PN TN 0, IR IEN R LM, LA LU Pi4%k:

Jz rel ;% A=0, JI| PC<PC+2+rel




TWHRFEE SRR FZR
;% A#0, | PCPC+2
INZ rel ;% A#0, JI| PC—PC+2+rel
;% A=0, M| PC<PC+2
B Gn T AR .
MOV A,RO
Jz L1
MOV R1,#00H
AJMP L2
L1:
MOV R1,#0FFH
L2:
SIMP L2

FEPAT IR B 7 4 S RO A IRIEL A 0, SR RS 21 L1 $0AT, PRI A AT 45 SR A2 R1 {4 OFFH.
MR RO I ASET 0, WP HAT, Wt 2HIT “MOV RLAOOH” $54. S & MHAT LR AE R1 111
H%T 0.

(3) AR TR S
LA AR R A LA W T 4 4

CINE A,#data,rel ;% A=data, 0| PC-PC+3
;% A=data, NIl PC~PC+3+rel
CINE A,direct,rel ;% A=(direct), JIl PC<PC+3
;4% A# (direct), Nl PC—PC+3+rel
CINE Rn,#data,rel ;# Rn=#data, 0| PC~PC+3
;% Rn=#data, JI| PC<PC+3+rel
CINE @Ri,#data,rel ;% (Ri)=#data, JI| PC<PC+3

;% (Ri) ##data, Il PC—PC+3+rel
54 “CINE A#datarel” [IThRESLK A BIAEMSLIEL data LLES, G0 R MEHIAE, SUBUFHAT; WEA
%, R . R, tnl LK rel ZERMGhR S, B “CINE A, #data, b5, IXFERIHIX 448 4 )
DA T P9 500 5 AH A5 o IX B FVETEAR 23 & 2 ARE A F IR, (ARG Ik AR T8 P9 25 LA 2 S Wik AN oK, BRI,
AEZARA TN CY I SRSEHUEFERIhae: W AT (A i) K, W CY=0; &N CY=1.
R AEFE P 7 i PR R CY lon] i i A TR 2L data KB A2/
BlandE P rAES B, 84 “CINE  A#0AH,LOOP1” LR —FIThRE, RIAIWT A EASETHAH; 45
4 “CINE  A#32H,CMP_R2” {FHNEEE —Fhohae, BUELES A S5#32H 1R/, BEJE IC $84 A4 S HAE )
FIWrEFAR2, CINE AUAGEFENT T CY AL IC $742fH .
[ 1-71 CINE {PiFl % .

LOOP1:
INC R1 ;R1<R1+1
MOV A,R1 ;A<R1
CINE A,#OAH,LOOP1 ;% A=#0AH, %% %| LOOP1 $h4T
MOV R1,0 ; BN, R1<0
INC R2 ; R2<R2+1
MOV A,R2 ; A<R2
CINE A,#32H,CMP_R2; th# R2 5 32H, # A<32H /I CY=0
CMP_R2:
Jc LOOP1 ;X CY #E4T#B7, # CY=0 % 2| LOOP1
MOV R2,0 ; BN, R2<0
SIMP R1 ; Bk#£ 3| LOOP1

(4) Pl 1 &R R4
I AR RS A W4
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TWHBTEE SIRRETFZRL
DJINZ Rn,rel ;& Rn-1+#0, | PC<PC+2+rel

;#% Rn-1=0, JI| PC-PC+2
DINZ direct,rel ;#&(direct)-1+#0, JI| PC-PC+3+rel
;# (direct)-1=0, M| PC~PC+3
f54 “DINZ  Rn,rel” HATHIZEHE Rn P20k 1, SRS 40T Rn RN AR RN 0, 544 0, NIRRT
KA, #5750, WRPALEHIT. “DINZ  directrel” 52 3L, FUZME 1 (EAEERAZLE R, 1)
JEAE direct H1,
[ 5] 1-81 DINE M. K N RAM 1 BL DAT e d Mtk iy o B v i3 28 10 AR5 80, Ik
I 8 ALikF]) SUM _H T, ik 8 f7i%%] SUM L ¥yt. SEFEFUF:

MOV R2,#0AH ;#3EH KL% R2
MOV R1,#DAT ;#U4E kA8 46 b % R
CLR A ;R BEE
MoV SUM_H,A ;SUM H %2 m#EZE
MoV SUM_L,A ; SUM L #p#E
LOOP:
CLR C ;CY LR
MOV A,SUM_L ;SUM_L ¥ b #E#EN B n i
ADD A,0R1 ;i —ANK
MOV SUM_L,A ;¥ An#yf§ 8 fi% SUM_L

MOV A,SUM_H ; SUM_H 8 meh#45i% \ B
ADDC A#OH ;G 3l fw

MOV SUM_H,A ;¥faty i 8 frix SUM_H
INC R1 BTkt 28 4t
DJINZ R2,LO0P ;# R2-1+0, JUBk3£%| LOOP
SIMP $ RN, L
R ,E—n GBS ARSI, BRI E S E A H R, EE S KB HE N
T2

T B, MNIUEE T AKES A R,

(5) TR AR G2

N T D 2 5 RV 7 (K A, B D R AR A7 A v P 7 IO 2 T, W BAT e AT g
HIREPBOE SO TR AL ERE P AR T B o W SEBLERE P TR 0 — e, R MO e
s Il I 7 AR R BB TRE P IAT, TREP T 5 B N RE TR R [R5 4 A 3R 1]
AHEL IR — 52T, I, 7R AR 2 S AL R i 2R R P I AT A, i [l MU s 22

BHETREF AR -
TREF AT W4
ACALL  addril ; PC<PC+2, SP<SP+1, (SP)<PC7~PCO

;SP<SP+1, (SP)<PC15~PC8
; PC10~PCO<addrill
LCALL addrl6 ; PC<PC+3, SP<SP+1, (SP)<PC7~PCO
;SP<SP+1, (SP)<PC15~PC8
; PC15~PCO<addri6
B4 “ACALL addrll” NEBETRS, %82 HUTIE, PCAEIN 1 PR, AR5 PC IR 8 RifilE 8 ik

NHERE, JndE PC N 1 G S Al PC15~PC11 V4 FREFFEAEHBIE & 5 A7, 2 addrl 1 /0 TRER?
AL 11 A7, FHEAZHERE N TREPT . 7ESEBRgmfEnT, addrll nTHAR S8R, 7 20T SN2 AR T
Fa 4 N S FREFIE AR RN R — AN 2KB YuFEI
f54 “LCALL addr16” KBk, %$aHATHE, PC e 1 =k, SRJGHE PC+3 G Hihk s AHERR, &
JE A addr16 IEAFEF S PC AT . KRR A& —Fl 64KB Yo N R TR 4, R FIgR A 1%
7] T S S E 64KB i 4 .
IR Al A AT P 4%

LR L3 R | PR | TR EUN | W | M
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1942,

FBTFEE fSRETFER
RET ;PC15~PC8 - (SP), SP«SP-1
;PC7~PC7 < (SP), SP+-SP-1
RETI ;PC15~PC8 - (SP), SP+SP-1

:PC7~PC7 < (SP), SP<SP-1

f&4 “RET” Al “RETI” [IhREARA, #OSIOHERE - 7 o ok 52 2R 7048y PC b, TS 5 1 L
[B] 3 W7 AT bR A PAT FEY . 5 BRI, RET B FRETFIRMIES, HAEHA TP AR; RETI FHh
KR REE A, N RERTE T Wi IR &SR P K 2

[ 1-9) F PR AR S 56 20H~2AH F1 30H~3EH WM EAE S C BOlS B . SERFUR:

MOV SP,#60H ;4 % H % JK #i 3k 7 #60H
MOV RO,#20H ;% —iFZ KA 4eHiHE% RO
MOV R2,#0BH ;% —iFE K i R2

ACLAA CLEAR ;AT EFERE—NREHE
MOV RO,#30H ;& —HEF X4t RO

MOV R2,#O0FH ;% — %% X % T R2
ACLAA  CLEAR HATERFBEZRE -ANEH
SIMP $

CLEAR:
MOV @RO,#00H; &%
INC RO B RIER R fe 4t
DJINZ R2,CLEAR;# R2-1=0, JUBk#t%| CLEAR
RET ;[

(6) R4
THRANERR UGS PC N 1, ANHEATATATERAE ,, LI RE 12 I S 5 I a), 028 ¥ 0 S i 2 e TR A
HARSHA N
NOP ;PC<PC+1

5. frEtEfR4

MCS-51 HFrHLIEf: S5 v — M AL P 2S CURRARALFR S8 ) A5 — B AR B AN P (4544 . Rk
REALERET, CY FR “f8N#8 7. H H KA RAM, AN RAM 1) 20H~2FH iX 16 M7 15576, R
128 AT, Ef5 A A7 /O Z50) (H P0.0~P0.7, P1.0~P1.7, P2.0~P2.7, P3.0~P3.7).
PERAESR 2 o ARk . BN ALIEE . (s BE U A GBS, L4k,

(1) PABIRIRS

PALIETR A “MOV Chit” Fl “MOV bit,C” Pidk. MiAEETRL TR 28 A2 B W 1-19 iR

119 (AL FeiEc
L4 & % I HE Z  fl
MOV  C,bit bit HARFIEAN C MOV  C,60H;CY < (60H 47
MOV  bit,C C HORAIEN bit H MOV  00H,C; (00H {i7)~CY

(2) PLERLRRLTEFHR 4
XKIEA I “CLR C”. “SETB C”. “CLR bit” fil “SETB bit”, It 4 4. AL B MO ZIEA RS
ARZEFI IR 1-20 P,
%120 M EMALEERS
iC 4 & % by I 5 fl
CLR C C HREEE CLR C ;CY<0

SETB C CHREHE 1 SETB C ;CY~<I




_Zﬂf -t .
WA FEF SINEFEL

CLR  bit bit HURATE S CLR  10H; (10H £7)<0
SETB  bit bit FURASHE 1 SETB 10H ; (10H fi7)<1

(3) fris% R4
RFLIAT 6 %, 0o “H7 “E, BT 3 4l ALIE AR IR A U Bl Wk 1-21 FroR.

12 fEEES
iC %8 2 b/ =
ANL Cpbit | bit FUREL CY Ml “ 57, 4i1HE CY ANL C,07H ;CY<CY A(07H £7)
ANL  C/bit | bit PUREHUR S CY HT “557, SRECY ' | ANL  C/O7H ;CYCY A (O7H A7HUR)
ORL Cpit | bit PHRE&L CY M “8”, 49RAE CY ORL C,10H;CY~<CY V/(10H {¥)
ORL Cybit | bit ARG CY M “o”, 45R4ECY 1 | ORL C/10H;CY—CYV (10H f2Ht%)
CPL C CY B CPL C ; CY=CY HUR
CPL bit bit FURAS IR CPL 65H ; (65H )~ (65H {71 %)

(4) Py ea 2
PR TE 2 “IC rel”. “INC rel”. “IB rel”. “JNB rel”. “JBC rel”, 35 4%, frfhliis A 1is

A RSN ER 1-22 TR

#1-22 R BIES
iC% & 2 I #E %
IC rel BERLAL A 1IN, FRIPHEAR rel JC LOOP ;# CY=1, ¥%|LOOP
INC el HERIAIAS 1, FEREEE 4 rel INC'CLEAER ;# CY=0, #%|CLEAR
JB rel bit RN 1B, FRIPH A rel JB LOOPI ;¥ bit=1, #%|LOOPI
INB  rel bit RSN 1 I, FEFHEE rel IJNB SEND ;7 bit=0, #%] SEND
JBC  rel bit IRA&A 1, FEPH 4irel, G bit f73%% | JBC TEST; 47 bit=1, ¥ %] LOOP, bit=0

84 “ICrel” PATHS, B HUEHW CY HE, # CY=1, WFEF AR, SUFTPABEE, ghaih
TR

F4 “INCrel” PATHIIGHLE “ICrel” ¥alfAH i : 4 CY=0, WIFEPRABE, WP APE, 488
PATIERESY o
RIX PSR AR AL IR S, HRELL CY WY ERE 5 77 B, 5 U S A 454 CINE
R, DMERYE CINE 58 2T R IR R CY JE— P PuE B B ) o
84 “IBrel” F1 “JCrel” XL, “INBrel” “INCrel” 2L, HAZMRYE bit FIHEMAE CY FIINZE
K e I AE )

F4 “IBCrel” Fl “JBrel” fEHAHR, FOZMETPHATEIE LK bit 1%, —4&4a2EF TR IIE
M.

1.3 MCS-51 B 5 HlB{AIES

YEGRIE 5 DA ATGE D R s AL FR A B o v T RE R AT IHON #HE 5 . DhR R dmes e 4, nlLL
FHARAIH LS Y Gt FEREA TR, A T — SRk . 8051 I dnes i FHIFEh$4 4 ORG. END. EQU.
DATA. DB. DW. DS. BIT, L8 Fh, FHZE U TH4.

1.3.1 ORG {44

/w.hayj.com  ##) vww.embedu.org ik vww.farsight.com.cn

JEE PR . www topsight.cn 2515 815, 400-706-1880 ,
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frAx G LU HTFEE SIWRTER

ORG 54 t ILAE UG e sl s SR ) TT 4R, T LA WM 0 T 4 H A5 R Py sl A TR e af o 6 —
ANBERER AT L2 AT ORG LURE AN IR > BEA AL 4 itk ELE SCER IRy 122 /N 2K . ORG
R — B O -

[#% :10RG %kt
FRIEA LS AR 16 AZRUE, ] URAFI 16 A 8 AT R4 . AR SR EA, A2 AR IE

M PR RIX R A I, b AR O S (O A B ARBEED A5 W0 SCRIEHS 0 2 4G,
ORI A R 10

ORG 0030H
START:

MOV SP,#60H

END

ORG Th#a2 M T START it ditil &y 0030H, 25484 M H 5 S48 9 fa A L2 A4 A 0030H F
BUIRAT T o

1.3.2 END {454

END & A brEUEACH 45 o), I g8 3] END & A5 1Fis4Tes %% END iEf), JLgmbdRil. K
I, AR HREAE R P G i — A END $5% Hiks Uk

[#7% :1END

1.3.3 EQU (=) fh#54

EQU ThiE4 H T4 — MR s A Fr A2, ZEIXAN %70 DUAEER etk . 2otk
BOZRIECE ], BRI T DO 8 ALEL 16 A —REHIEL . 4 AU DU RETT S R R, T LA
TR, WAURSEHTEA € it e EQU — BN -

4% EQU kKR

5
& F=%H R

it
STACK_BTTM EQU OB0H; Jt.J5 STACK_BTTM El % 60H
COUNTER=10 ; 3t.J& COUNTER 4 60H

1.3.4 DATA thig<

DATA D i 2 FK 0 B ik WA D 52, B R DLRIRAE AT I i R U E IR 45 FE AL 1 745 44 Bk . DATA
ThiE4 5 EQU Tt M T EIX 2 : EQU % SN FAF H AR UL UG, 10 DATA 5& XI5 4F 44 7K
BOAIXFPIRED, # DATA D30 W AU T Sk BOR 2 - 620 -

DALAY_TIME ~DATA OAH ;DALAY_TIME & ¥ OAH

1.35 DB thig<
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LU HTFEE SIWRTER

DB BN SC bR 4, T8 S NMEE LU 0 IR, 4 Al X Al el e %08
TR WIS A il B G, AERIE IR AR A EseA IR, N E A O R RE ORI R P 1 AT
HERIEAAGE PR, BRI A7 WHRIAEN % 16 A7 AREE, HILE R IR
8, HZANRIENMBAE A DB thfr s, RIEXZMMBHLLE S0 TIF. LIEXPAT TSR, LRG|
ST, BT AN, PR AINSCR A AR T, TR T NS 2 I e,
Lhe = WoF

[#75 :]1DB FiskF &

it
DB 02H
DB 01111110B,001100008,01101101B
DB "C","57,71"

1.3.6 DW {4$54

DW Rk LA hda4, HT NUEFRE P Al as A X 3oe —A e — 8, Fil DB 32X 4T DW
&SR — AN (RIS, DW bR A B E R ke X 16 frkbhl (& 8 fi7Eny, K 8 MififE), ok
WS R

[#75 :]DW T2 &
a4

DW 12341,54379,10110100101110B
DW 456%375H,83+295H, "YZ" ,72h-456

1.3.7 DS this%

DS #x s MAFE R4 . H— I AR -
[%%:1DS k%R
DS $54 A LRI g fE e M ILAR S okl CalsehrdEisthhl) JFATIE — e S 0a N A7 500, DAL
PATEREAE . AT RTHEE (80 H DS 1A “RiE0” ke . #ilin:
RESERVE:DS O0O5H
TC4ife P& 3] DS W55k B 2 N RESERVE HuliEFFAATIE 5 AN NAEHTG, R 6 MEffi ek eifr
fitt Gt 12 ) AR

1.3.8 BIT th#54

BIT A AT EIRAE Do di5%, M40 IAF SR U A IR . BIT 54 (1A% 02 :

FHAM BIT st
IR AR D RE AT BIT A7 34 AL RIS H AL i 745 448K A, BIT )& L I 7 4F 24 K2 — A4
(R VAL L F

MSS00_FLG ~ BIT O7H

SIGNAL BIT PO.4

MS500_FLG #1SIGNAL % BIT #5115 S AT LAY A A7 s hikAE AT, 3 rh MS500_FLG HI# B Hhik A2 07H,
SIGNAL [HJ4)EEAL ik PO.4 .




19622

(PR e U HTFEE SILETER

LAUEJUHS TR T 51 R BN 5 R SRR & HE, UANER RIS ZEAE1, L0
SCERFP 2Nk, A REIE MBI F A58 0 WLV G v = IO GRe iEAET o

1.4 MCS-51 C4RiES dmiz=fl

FALP ALIE AR 00, i BT P 10 I Al A o 2 2 Y i N 5 o b — 28 O 2 (it o A S4Bt
eI MR 2 iR AN L 53 A0 4 W D Ze iy, FARThAREQ N . 7Edm 2k PO.0 bfie— Mk,
TSR A I, R XAl It P2.3~P2.0 1X 4 MR TZRFTOK AN AR O R R ik,
P2.3 i i, P2.0 i ARAL, FRRAT SRR 1, SRR AIZA 0. AR, T A 4 MERIT,

HEERIL 16 FRRAS, LR R I THEUL BEAE 0~15 Z )il 4 HA7R AT 4 K 3oR 0, BT BEIY 0000;

4 AR esidon 15, BV 3bHI 1111, AR

HUE A 118 s HLBR A L e Z U

o 89S51 & 51 RFNHP ALK —Fh, SIHTHRENTR 4T 5E 4 8051 .

o EEEMIKIINE N HEEA AL T, P0.0 i R EAHFHEE Vee, BEIR R BEL R

PO.0 G Fa B R, DA, DRI T DB A PO.0 i 11 PR R 1R T 24 i B 5 a1~ o

o T AL G AR G 9K RE D AT R, IRIRANE T AN B A BLER R0 A8 BT i B (1 LU

A G A e, e SO AR ST A AR L, AT AN VCC S RO AR AT BH A
JARSS RO B RO

FEREFP A, SO A TS % T o (R LU I S B L R IH A R U % B s 3y, Y
AT BEIX AL QAT R T K, PEACEE T, DR b 205 S W sl ARG 0 81 45 B2 52 B U AGr
o FEFRAEWIE 1.19 Fis.

VCC
EXo
47kQ —
Y
P0.0 6—
PO.1 |— WEH
P02 — “*&tﬁ”
P03 ——
P04 |—
P05 ——
P0.6 |——
P07 f——
89851
P27 —— Vee 5
P25 f—— [> o———H ; 1
P24 b—— 510Q L |
(5] E— SO 2
P21 [ P2 i M1
P20 4Do—5|g2—*‘|<1— R
1.18 Ik fa B i R e AR I P i ] Bl 1,19 JE 4z i RO A AR PR

SEREMI G i 5 R P i) 1-10 FioR.
(6] 1-101 H 4 DRG0 WoRtB U gm s SR . AERF A — A TR MAIN FIpAS R
KEY_TEST #1 DISPLAY . MAIN F&/52& MGG, A KEY_TEST #1 DISPLAY. KEY_TEST (1))
RER B AL N AR RO, WiR A B B E RS INC_FLG, ffifig DISPLAY - FE7HK
TN 1 7R, DISPLAY SERGX I TAER, 25K KEY PROCESSED Friifi'E 1, L@ KEY TEST f1%
FPib ks A H . ARSI R TR

INC_FLG BIT OOH ;¥ INC_FLG it {8 % f #u it OOH
KEY_PROCESSED  BIT O1H ; ¥ KEY_PROCESSED i & 7 f #1 4t 01H
KEY BIT PO.0;# KEY Ji{& & {33k PO.O

STACK_BTTM EQU 60H ;¥ STACK_BTTM Jit{& 4 60H

EFAER: www.hayj.com #ARFER: www.embeduorg 1EdkFEE: www farsight.com.cn JEm | B | R0 | AR | R | EUN | Em® | M

BB FERE: www.3g-eduorg EKPIEEE. www.topsight.cn Z1H 815 400-706-1880 , 3909 - 30 -




FWRTEE SRETER

ORG 0000H ; £ H /5 )\ 0000H Fr 4 4T
LIMP RESET ;0000H~0030H A # Wi i &, A fb 4 E H At KA
ORG 0030H ; Bk# 2| 0030H AT
RESET:
MOV SP,#STACK_BTTM 315 MR 3k
MOV  RO,#OFFH : RO<OFFH

CLR_RAM:
MOV @RO,#OH
DINZ CLR_RAM

; AT HATEZ RAM K

;¥ RO P 1 ) RAM 3 L3 &
;B % RAMHFEE E—iE4, HZ R0O=0

MOV P3,#0H JRIEEE, 4 NHERITA K

MAIN: ERF

ACALL KEY_TEST SRR RN T 2T

ACALL DISPLAY AAUHE R R TR

AIMP MAIN s BkAE B Huik MAIN, 7 IR7E 2R
KEY_TEST: JIERNTRF

SETB KEY S MRS E KT M E &

MOV C,KEY sHEI BRI CY

JC CLEAR_RET ;ECY=1, WHAEEAET, KE

JB KEY_PRESSED,KEY_TEST_RET

SHEET, RERERREREEEHAER. FEHAE, NEE

SETB INC_FLG
KEY_TEST RET:

;¥ INC_FLG B 1, A ¥Fit¥ie1

RET ;EE
CLEAR_RET:
CLR KEY_PROCESSED  ;# %47, ¥ % KEY_PROCESSED
RET ;EE
DISPLAY: U HEERTFER
JINB INC_FLG,DIS_RET ;& A#it#ml, &E
CLR INC_FLG s AE —REHAELE
SETB KEY_PROCESSED SHREBEONENTEME 1
INC COUNTER ;i 4o 1
MOV A,#OFH ;A< OFH
ANL A,COUNTER ; 51 COUNTER #1% 4 {
MOV P3,A ;EE T
DIS_RET:
RET ;[
END SRR XHER

1.5 MCS-51 BRK#l CiEEEMN

1.5.1 H CESH KRBV

FUE G S AR R R AT R AP PERE A TRk, (HHASE PRGOS, WRERCRITT,
HATRB PN e 22, dEg AT, A S ECEAD RSN, T C 15 DILE LR e A
BACHEEIA AL TIFRN AT E, O TR A T3 FUR BRI BT A, 380 1) 2 Msfs. C
WrE BATLGE S TSI ERI LS, s i

EFAEM: www.hgyj.com #ARFE:. www.embeduorg k8. www. farsight.com.cn 13T | b3 | =

SEh BHCPERE . www.3g-edu.org  HIEEPISERE: www.topsight.cn &i88iE. 400-706-1880 , 15010390966
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fFAK HoH U HTFEE SILETER

o WLUKIREEIMRIT A IFERE, Rtk —SE MRS, FIFElRA, M CES g .

o WLUSEIUERAERI ik m A, C 1B 5 R IB R 5 MR ARG M . A AT, TR /N TR |
9 TAEAE.

o HLETNIABHERHTE CBIEFAA. RAM ) W TAE. EIL4E S PN T REF e
FHLRIR, X — R A% ZKI A S B 2R TAE. i CiEFa, REAE A — 4
IR, kst e Al A G BIR, RAATEN T, MG R08 % 7 N LB A HLEE I8 B o]
ey R I 22 4

o YEIFT—AEE (E CIEFHHARED 5, [TEBEIIAFRME MCU BN, ELmESHRA
FoR g 5 AR, R = el Rt R 25 i CIE S IFRI, f546 ANSI C bRl T AR AL E
e, DR — B0 S R A DG R A RS VA B A L, 3k T LA (S A A 2 LA A S 1 2 oL E

o C B data. bdata. idata. pdata. xdata Fl code ZEAFMitins ISy, XA WL P B g 2= 0] . Ak
B A AT iy 2 A RIFE A7t 23 W) 80 A AR 5 B L3 18], 1 HL C 3B 5 4R AR AR e 2R 2, e Fa%t
SERIAREE, BOCHIIE SR TR AP RE AN RS VE . C B 5 g Ay e 08 H 2 S BT IR 5 R 7 (A DR I 2
I HARME T AR e B P A, A 1528 T S S AH ARSI (], I H C 1B S mikdsaeis B
S — e G A

AR C 1E5S RIS & LS5 5 S K 5%~20%, HEH T E SRR RE, &
A A R FE AR T ORI EE 3 &, A RN 22 5 AR AROCHE, AL, DOz s
AR KR TRy, EEAEH eI & T2 P ke P R AR e Rk, AR C 15
R HURE P & o — Rl

1.5.2 C51 FEFHIHT

B 1-10 251 T anld 1.18 P B s I (V0 g il 5 A2 7 ARRLE 2, AL e 5 Wil A MU PN,
TR WL B R AR S AR LU AR, R B I MRt . S 4h, TLWTE S 'S RS nl e tEAS
U, T BN IO (R A LA B B, LA R R N e i . R C B S S R, e
TORG I B R A LEE A SRR O RE 5 4 S AT A BB SR 1 T NV A R %, YRR e 1) R 33 R 44
PR LR, FEA L AT DR R T e NG AR T 265 00 H 33815 5505 BAZE S LR T 25 s >R IR 52, AT RAIE
BN RGE I RE M,

T2 H T IhRESE MR C51 S 905 MR .

[ 1-111H C51 5 F ESH 1-100 AT 9615 5 e 55, B2 M mT st RO 5, 55 2 4E 9

#include <reg51.h> 1/ X2, 135X reg5l_h & E# &
sbhitkey=P070; /7% 7% & key £ XA PONO
bit processed; 1/ EX—ML% & processed
void main(void) VIEXT 3
{
unsigned char counter; //E X —A % & counter i Rit#k
while(1) VIEAEED
{
if(key==1) I/ REAERT, PATARES BHiEH
{
processed=0; LIEE N “RAFE
continue; /73R “while(1l)” &4
}
if(processed==0) I/ RAREET B a L8, JATAREST EWIES
{
counter+=1; /7T e 1
P2=counter&0x0F; //E P2 30 B R
processed=1; [/ E N B A

EFAER: www.hayj.com #BARFER: www




_ZE.TE .
WA FEF SINEFEL

1.5.3 C51 f&F7E Keil C51 FHIZRIFE. (FE

WAL IZ AT C51 BRI R I 2 Keil #AT o Keil FAFHITELN U] WA EE 9 %, 1X BN AE — i 2235 1],
DU F3e 5 76 o 1 A 5570 P SEfrsh T 5 AR

1. BEFPHIGEN Y E

PP H Keil #At, HEIGEIEM 2% Keil BAF, 211 Eval AT LLE 2 hitp:/www. keil.com T 2L,
FOPIRS 5 Windows P17 2Rl XLt A HBEE T

JA ZhuVison2, Ul SFTFF Gt A 47 FF 1304, #ti“ Project=> Close Project” 32 BRG] . #.5“File>New...”,
HIF—ASHH SN E O, EXAE DB 1-11 PR T . MACYZ G, P “File>Save”,
IR SO DR A, A I B By R4, — M CIB ST “o” YRS, KEKH
i 444 mytest.co

M. “Project>New Project...”, HIIXUEHE, FRGE L TRE N2 F, XEEAN test, N
PUMANY R4 . Bl “ORA 7 &ML, IS ASUHE, Wil 1.20 Jrass

Eile Edit Yiew Project [ebug Flgsh Fepipherals Jools JWS Tindow Help

AEE@ ® : A T T e T #h1 & O DEoeTE

3 Targst 1 crr

Vender: Atasl
Deviea: ATBESSL [~ Vse Extended Linker (LXS1) instead of BISI
Family! BCS-51 i t

Duts base Desgription;

[ Areacss A | [6951 bused Full Static G5 eemtroller with Thres-Level fr
[ arusrst 52 1/0 lines, 2 Tiners/Counters, & Interrupts Sources, fat
51 aosree 4K Flash, 128 Bytes Un-chap HA

[ arasLsst

[ ArseLssz

03 arsaLys:

[ amaayee

(L] aTssLyves

[ ATaesaniz
Omzg

[ Arergsse

L amasssa »

B [& Qe |
] (o= ] = |

1.20 CPU iEHt% 0
XA HE EL SRR TRE P T B pLE S, X RE Atmel AW 89S51 5 /v« Hiii ATMEL Hijlfl
) “+7 5, RIFiZE, B 89851, SRE R “HE” Hd, SRBELE 1.21 R AN g
HE, I i) & 7 EOR R UER) 8051 S A I TR, Fdy “J2” &l

\_‘v Copy Standard 8051 Startup Code to Project Folder and Add File to Project ?

&

Kl 1.21  briEa SRS E £
IO, R TR DRSO s I T “Target 17, WillE “+7 5, il “+” SEIF, wLEST—ZH
“Source Groupl”, 75 EFANHENNA G 5 UF PERFEF AN, JIiEWR
B “Source Groupl”, ik FEx, ARG HE RAAGHE, HI—A Mg, wiE 1.22 ik,




1 Y. .
TWHRFEE SRR FZR

I‘I-'._.E_a — Wizion?
File Edit Wiew Project Debug Flazh Peripherals Teols SVCS Window HY

S = = Gy

Iﬁl & |'l'arget 1

-84 Target 1 ‘
DF

Options for Group ' Souwrece Group 17

¥4 Bebuild target

#dd Files to Group ' Source Group 17
Targets, Groups, Files. ..
Remowe Group ‘Source Group 1 and it's Files

¥ Include Dependencies

K122 SncpEs s

e rh HA ) “ Add file to Group”Source Groupl”, HIL—ANKF G HE, Bk T #k V5 A4 . X5 mytest.c SCIF,
WA IATNE , ARG “Close” A BRI ATk [9] 3 % M o <& 1] j5 ¥ “Source Group 17 FifhNs,
Al LLE 2 mytest.c SO LRI, AU SO 44 B o] UST 2 05 FE )7

FEP RN — S TRNEIIAT R E . PRl AR B, R TRV P ) “Target 17, ARJGEFEH H g
f] “Options for Target *Target 177, 7E5 H HIXS 1 HE k£ Output ” $r%5 0T, &% T “ Creat HEX File”
AT ) S IEAE , SR 9 135 5 3t 2 22 AT LA T 5 11 hex SCAF - “ Name of Executable " 72142 B 1) . hex
SRR, X HSON “mytest”, W1 1.23 fizse

[E) File Edit View Project Debug Flash Fepiphersls Tools SVCS Windew Help

=== A Gy -léd @ & @ DE
- NR AL AN |Targ
| Options for Target “Target 1°
Zlx
=4 Target 1 Device | Targst Uutput |Listing|C51 | 451 | BLSL Lecate | BLSI Misc| Debug | Ueiliti
2 Seurce Growp 1
= mytest. e telect Folder for Ohyecis, .} Hame of Executable: |mytest

(¥ Create Executable \mytest

v Debug Informatio v Browse Imformati | Merge3ZK Hexfile
¥ Create HEX Fil HEX |HEX-80 -

Kl 1.23 &P H HEX XA

BOE AP TRERIUG RIVTHEAT 4 . 14k, JEFE “Project>Build target” TJ LIXS il TREE TR, WIRY
RSO CAB G eSO AT S i3, SR G PR LU= 2 H AR ACRS s an L%+ “ Project>Rebuild All target
files” FF 2% AT TREH WATA XA BBl FRATHmEE, AR5 FHEB L HARRAS; 1
WIRIEPE “Project>Translate ....”, TN MFT CAFEAT g1, AT, WAL= A1 H AR
i,

PL LS EmT DU T R AL T g BB TR R 1.24 R, MWARIG A .
iRk, ATRE . TG A TR T E .

G R R 5 S R ELAE R A D ) Build sirh, nTRASEIQIE] 1.25 ProsrIsiR, o T AN
mytesthex [0, ZSCAFRITT R AR S B o [AIBIE AT BRZRE P AL E (code=37). I
RAM & (data=10.1, /MEER “Bi7). HME RAM FUEFE (xdata=0) %5285 H. Rt ANE LT
— B HABAH IO SO T4 T Kedl BIUTE 5.




;Zﬂf.ﬁ? .
LB FEE SiLETFERL

Build target 'Target 1'

compiling mytest.o...

linking...

Program Size: data=10.1 xdata=0 code=37
creating hex file from "mytest"...

Le e

- "mytest" - 0 Error(s), 0 Warning(s).
'&\ |1'arget ! J [ AT T/ Build £_Cornroand _Find in Files [
124 HRGTE. BCE A T AL K125 ARgiEd i E e N

2. EFHESERK

FEPe IO BANIALE R A AR5 AR, T DU A e S8 2 R R i 2 ik ol ASRHIE 5 2
FRVRE P A2 73 BEI 2T ) H A o

TRERHATI G SRR IILA)G, #4168 [Cul+F5)] BiEEH “Debug—> Start/Stop DebugSession” H[J i
BENPEORAS, SRR L T — AN T Sas AT MR TR 4%, anl&l 1.26 P,

MmELS B SR LYy OE >

K126 SzfrAniEid T R4

Debug . FARFEFZEH N A BIAKOE R AL 1817 B, 5.0, SRR, PUT78 490 . 8173
MEAT R ORA S FTIFEREE . LSRR . SOl . WS 1 AR E VG A TR . A
fEE L, PERE T TR S5 2 I PRS2

YT 1-11 RSP, T2 2] PO A1 P2 v A A g i, PRUHAEA B2 19 e 2207 L EOW %2 PO P2 % [
RS . ZEFE “Peripherals>1/0-Ports>Port 0” Al “Peripherals= 1/0<Ports>Port 2”7, 7EF & 4 IR
PO. P2 CIPIRAS, TEAERFIBAT I SCE PO.0 (R “Parallel Port 07 XHFAEf i A7 I A AL IEAE),
JE M %S Parallel Port O 6 TG AHE - &AL ARG, PP S Iz @8 “17, B 5 MR sixir
A €07, W 1.27 .

L:yDocuments and settings\zms\By Documents\mytest.cl
Bl File Edit Yiew Project Debug Flash Peripherals Tools SVC5 Windew Help
2Ea R | oel=s s manml Z#|@E|4
RMEO®EOn 2 AEVEEE
Jz #include <regSl.h>
Register [ value | sbit  key-PD*D;
bit processed;
FhRegs woid main(woid)
v 000
ol 000 { ) )
¥ D300 unzigned char counter;
r3 0::00
r4 0200 Larallel Fort o I
¥5 0x00 Fort O 1)
rf 0x:00 T Bits 0
¥7 000 O IFE PR besseazo;
Sy - ins: [P GRRMRRRR | e
a x
b 000 if (processed==0]
o Ep 0x07
sp_maik 0x07 Parallel Port 2 er+=1;
dotr Us000n Port 2 unters0x0F,
B § C: 050000 T Bits ||
gratates 0 P2: [0aFF oo e o :
ser 0. 00000000
- paw 000 ins: 0FF VWV VRV

B 1,27 JFAT S 7 EOG R HE
W I 1.27 PR A AR EE S, B RIS AT, Rl TG 05 BLEAT, B 1.26 R « B
PRAESL R R AR e, Wik 1.28 Fios.

%00 BB OE 2|

B 1.28 i ELIEAT I RS AT R T H 4
BEE s “Parallel Port 07 S UFAE P 547 B A R IR T 5 U Al S s i~ , FRond Al
WS, A TR TT . B PO.0 HU754k, “Parallel Port 0”7 XHUFAE FLR A2 kA28 4k, Wi 1.29 Fis.




_ZE.TE .
[ FAR SIGERE TWHRFEE SREREFZEZR

] %] #include <reg5l.h>
Rezist 1 Valu ] shit key=F0*0;
E bit processed;
e g:
E a 000 void mainivoid)
Ferl 000 ¢ .
2 000 unsigned char counter;
3 000
4 Uzug Parallel Port 0 L
5 000 Fort 0 1)
& 0200 T Bits 0
ey T 0200 O BAFE Y | Lesseazn;
Hhin s G0 dns: PR pm MR | fLoues
a z L |
b e ifiprocessed==0)
p 0220
=p_max 050
1 dptr 00000 R -
L ] C.0x0008 T Bids i || e
o states 129539085 - T o
sec 4T, 10512291 ,._.._
[+ pw 000 |'ins Vﬂxm [MTTITT =T |

129 (0 40 AR 2
3. HHOREFPREES K

FH T8 L A Ol B SR, BRI T B s e i o o USRIl 7rf, LA
F 2 printfQ) i A1) IRE P # BEF T A 7 1 DU 4t o

FTFFH b o 1 (0 7 VRl B @ AT AR T A I “ 17 W AT M, 2 Ja st/ 32 6 1 A
A “Serial #17 75, B R H R AEIX AN B D R o ST (E LSS, mTLLESE “ Window>
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